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PREFACE.
This book covers basics of ICT like Windows and Accessories, Ms Word Processor,
Ms Excel (Spread Sheets), Ms Power Point (Presentation), Ms Access(Data Bases),
Ms Publisher and web Design moreover each of them having over 25 resourceful
questions for reference and simplicity.
In trying to write this book, I have made it so simple (Simple — Complex) bearing in
mind that most learners/students have insufficient or no background knowledge
about the use of computers.
This book does not only predispose on the student‘s use in school but to anyone
outside there that may be willing to learn how to launch and use IT basicprograms.
It is however important to note that the author has carefully studied the habitual
National Examination computer studies/Sub ICT syllabi and has carefully
complied content and resourceful papers from resourceful heads, so interesting,
and moreover comprehensible to cater for this field of teaching ICT at different
levels. It is therefore important for the students and teachers to snatch themselves
a copy so as to ease the teaching — learning process.
This manuscript is also an inspiration from the 0‘ level and recently rationalized
secondary schools A‘ level Curriculum for ICT and Sub math that affect tertiary and
university entry prerequisite.
It has also been an inspiration that has been as a result of constructive criticism
from our fellows in the field and my own students that have driven me to come up
with such organized manuscript as a need to strengthen computer skills in schools
and at individual level.
Compiled content herein is to guide the teacher and learner during practical based
sessions and partly theory but majorly aims at equipping learners with computer
skills.
NB. To my fellow readers/users; I am aware of a number of ICT study pamphlets
and text books and guides that have already been published and steadily supplied
country wide. However, “Computer Studies/ICT Practical Guide” as a guide book
has steadily and carefully been compiled and revised ‗by the teachers who have
tested the hiccups in delivering of content in this noble field.
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INTRODCTION TO WORD PROCESSING.
An electronic Word processor is application software that enables the user to
create, edit, format and print more professional text-rich documents.
A word processor (more formally known as document grounding/preparation
system) is a computer application used for the production (including composition,
editing, formatting, and possibly printing) of any sort of printable material
Computer

word

processing

is

application

software

that

encompasses

the

production of professional looking documents. These documents may include the
following; memos, circulars, preparing letters, greeting cards, doing simple office
works to mention but a few.
In a typical office where documents are typeset, formatting and editing of such
documents becomes a nightmare where manual modes of document production,
filling and transmission are used.
In order to minimize and eliminate such hustles, several electronic devices and
services by computerized systems and electronic typewriters have been developed
for more efficiency and effectiveness in document production. There has always
been a need to come up with better writing tools to improve on efficiency and
legibility of the written work.
Therefore, computerized word processing systems have gotten easy to use
document edits and formats features capable of making documents look more and
more business like if well mastered. Some people and organizations earn their
living by producing documents for others using computerized systems.
Therefore, it is important that learners get introduced to the basic practical
knowledge and skills of word processing in order to be able to produce and
communicate documents better.

ELECTRONIC WORDPROCESSORS
Word has got a number of versions and these include the following
a) Ms Office 97,

d) Ms Office 2007

b) Ms Office 2000,

e) Ms Office 2010.

c) Ms Office 2003,

f)

Ms Office 2013 and 2016
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Examples of word processing software/applications include;
i.

Ms Office word processor.

v.

Apple Works.

ii.

Word pad.

vi.

Professional writer.

iii.

Lotus 1, 2 and 3.

vii.

Word Pro

iv.

Corel Word Perfect

viii.

Office org.

ADVANTAGES OF WORD PROCESSOR PROGRAMS
•

Easier to use due to automated features such as Word-wrap, autocorrect
and auto complete, find and replace feature etc.

•

They have superior editing tools such as spelling checker, the Thesaurus,
etc., hence making editing easier.

•

Can store documents for future retrieval.

•

They have superior formatting features that make a document more
appealing to the reader.

•

The user can produce multiple copies more easily.

•

Copy and move (cut) operation make it easier to manipulate a document.

FEATURES OF A WORD PROCESSOR WINDOW:
Most word processors have common features. Each task appears in a rectangular
area called an application window
1) Title bar.
A title bar indicates the task currently running. On its right are the minimize,
restore and close button.
2) Menu bar.
The menu bar provides the user with a group of commands. Each command has a
drop down list, when click used to create and manipulate a document.
3) Toolbars/formatting tool bar
Toolbars consist of buttons of commands (icons) that provide shortcuts to
commands available in the menu bar. The two default toolbars are the standard
and

formatting
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The formatting tool bar
Styles & formatting

Figure 1

Font list

Font size list
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Line spacing

Bullets

Indenting

Increase &
Decrease Font
size

Color (font,
line, fill)

5) Status bar
The status bar is the communication channel between the user and the application
program. It displays the current page, section line and activities such as file saving
progress.
CREATING A DOCUMENT USING MICROSOFT WORD.
While Word 97-2003 look alike and are compatible, Word 2007/10 radically deviates
from these versions in the look and menu layout. There is no File menu and once text
is highlighted/blocked, a floating formatting toolbar is displayed above the selected
text. Moreover, documents saved in 2007/10 format cannot be opened in the previous
version unless you save the file in compatibility mode.
The appearance a Microsoft word processor window
This is the work area where you create your document. It resembles an ordinary piece
of paper.

Figure 2
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1) Document Typesetting/Typing Text.
When typing, once the cursor reaches the end of the current line, it automatically
jumps to the next line. If a word does not fit in the current line, it automatically wraps
at the beginning of the next line. This is referred to as word wrap.
2) Saving a document
•

On the office button/, File menu click the Save As command.

•

Select the storage location from the Save in list box.

Type the name of the file in the File name box then click OK/save.
3) Editing a document
Making changes or modifying an existing document is called editing. Some editing
operations include:
4) Deleting text, files and folders.
To delete a character, a word or a block of text:
•

Highlight the text to be deleted.

• Press the delete key or the backspace key.
Note:
• Delete key erases a character to the right of the cursor while the backspace
deletes characters to the left.
•

Use the type over mode to write characters to the right of the cursor or insert
mode to insert a character(s)

5) Find and replace
Find and replace is used to locate a word or a phrase and replaces it with another.
To find and replace a word or phrase:
•

On the Edit menu, click Find or Replace.

•

In the Find what box, type the word or phrase to find.

•

Click the Replace tab. In the Replace with box, type the word or phrase to
replace the target word or phrase.

Figure 3
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6) Spelling and grammar check.
Spelling and grammar checker automatically locates wrongly spelt and misspelled
words and grammatical mistakes.
To spell check a document:
•

On Tools menu click Spelling and Grammar or press F7.

•

In the Spelling and Grammar dialog box, misspelled words are shown in red while
grammatically incorrect phrases are in green.

•

From the suggestion list, select the correct spelling or grammar.

•

Click Change (All) button. To ignore, click the Ignore (All) button.

7) Thesaurus.
The thesaurus allows the user to automatically find words or phrases with similar
meaning (synonyms) or opposite meaning (antonyms) to the one selected.
To use the thesaurus:
•

Highlight text.

•

On Tools menu, point to Language then click Thesaurus.

•

Select a synonym or an antonym.

8) Autocorrect and auto Text.
Autocorrect and Auto Text are used to automatically correct a commonly misspelled
word and insert a predefined text when creating a document.
To create an autocorrect or auto text:
•

On the Insert tab menu, point to Auto text, and then click Auto text command.

•

Click the Auto text or Autocorrect tab and type the autocorrect or auto text.

Click OK to apply and close the dialog box.
9) Undo and redo.
Undo reverses the most recently executed command while redo reverts back to the
cancelled action.
10) Superscript and Subscript.
A superscript appears just above the rest of the characters as in cm2 while a subscript
appears just below other characters as in H20.
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11) To make text superscript or subscript:
•

Highlight character(s):

•

On the Formatting tool bar, you can directly select it i.e. X2 or X2, or click Font

On the Font dialog box check superscript or subscript.
12) Paragraph formatting.
A paragraph is a special block of text dealing with a single theme and starting on a
new line or indent. Some of the formatting features you can apply onto a paragraph
include: alignment, setting tabs and indents, drop cap, bullets and numbering, line
spacing, inserting columns and page breaks.

13) Alignment.
Alignment is the arrangement of text relative to the left margin, center of page or the
right margin. The five major alignment options available are the left, center, right,
justified and force justified.
To align text:
•

Highlight the text.

•

On the Formatting tool bar, click Paragraph.

•

In the dialog box, select the Alignment option then click OK.

14) Line spacing.
Line spacing is setting space between lines, paragraphs or blocks of text.
15) To space lines:
•

Highlight the lines of text.

•

On the Format menu, click Paragraph.

•

In the Paragraph dialog box, select the line spacing option from the line spacing
list box then click the OK button.

16) Setting tabs and Indents.
Tabs refer to definite cursor stops when the tab key is
pressed.
Indenting is moving a sentence or a block of text away from the margin using the tab
key.
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17) To set tabs and indents:
•

On the Formatting tool bar menu, click Tabs.

•

In the Tab dialog box, set the tab stop, alignment and leading then OK.

•

Press the Tab key to increase or the spacebar to decrease the indent,
alternatively, click the Increase/Decrease indent buttons on the formatting
toolbar.

18) Drop cap.
A drop cap is a large character in a paragraph that occupies more than one line down.
19) To create a dropped cap:
•

Highlight the paragraph you want to begin with drop cap.

•

On Format menu, click Drop cap.

•

Click Dropped or In Margin.

•

Specify the number of lines and other options then click OK.

20) Mail Merge.
A mail merge is a tool that aids the users create one document and be able to send it
merge it to a multiple of recipients.
•

To Start a Mall Merge: Select mailings —>Mailings, start mail merge —> you can
select from the dialog box an option i.e. ―start a step by step mail merge‖ or you
can use a mail merge wizard.

•

To Select a Data Source: In the Mail Merge task pane, select the appropriate
option under Create recipient list and click next. Perform the necessary tasks and
click next when you‘re finished.

•

To Insert a Merge Field: In the Mail Merge task pane, click and drag the
appropriate merge field to the desired location in the publication. Use the options
listed under more items as necessary. Click Next.

•

To Complete the Merge: Select the desired option under Create merged
publications and performs the necessary tasks.
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21) Text bolding, Underlining and italicizing.
Bold

Underline

Strike through

Change case
Font color

Figure 4
Italics

Superscript
&

Text highlighter

Subscript

22) How to Bold
Press Ctrl + B
Click the ―B‖ icon on the Home tab at the top of Word
23) How to Underline
Press Ctrl+U
Click the —U‖ icon on the Home tab at the top of Word.
24) How to Italicize
Press Ctrl + I
Click the —I‖ icon on the Home tab at the top of Word
25) Saving in Ms-Word.
•

If saving for the very first time...

•

Click: Office button+ Save Type File Name+ Choose Location+ Save

26) Keyboard Shortcut.
•

Ctrl+S+Type File Name + Choose Location+ Save.

27) Saving after Editing.
•

If you want to change the File Name of the edited document from the one you
started with but maintain the original document.

•

Click: Office button+ Save As+ choose format +File Name+ Location
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28) Saving while Editing
•

Press Ctrl +S

•

Click the save icon on the top left corner of the word window.

OR

29) Word offers five views of your document:
1. Print Layout View—this is the view Word users generally stay in during most
of the editing session.
The Print Layout view displays your document exactly as it will appear on the
printed page when you print the document.
By editing in the Print Layout view, you can more accurately see how those
changes will affect the final printed document.
2. Outline View—the Outline view button enables you to manage outlines you
create in Word.
3. Draft View—the Draft view hides all margins, pictures, headers, and footers
from your document so that you can see and edit strictly the text inside.
Press the Delete key (which is labeled Del on some keyboards) or Backspace Key to
delete characters where the insertion point appears.
Every time you press Delete, Word removes one character to the right of the text
cursor (including a space, number, or even a blank line if that‘s where the insertion
point is positioned).
When you press Back space key, Word removes one character to the left of the text
cursor.
F5 - Displays the Go to dialog box.
Shift + Enter-Moves the text cursor to the next line but does not start a new
paragraph or insert a Paragraph mark.

EDITING COMMANDS AND KEYBOARD SHORTCUTS.
Ctrl+ left -arrow Moves the text cursor to the beginning of the word.
Ctrl+Shift+left - arrow Moves the text cursor to the left and selects text as it moves by
highlighting the text.
Ctrl+Right- arrow Moves the text cursor to the end of the word.
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Ctrl+Shift+right-arrow Moves the text cursor to the right and. select text as it moves
by highlighting the text.
Up arrow -Moves the text cursor up one line at a time.
To print.
Select printing options like printer & number of copies
Click: Office button + Print + Print
Quick Print (sends the document directly to the default printer without making
changes)
Click: Office button + Print + Quick Print
Print preview (preview & make changes before printing)
Click: Office button + Print + Print preview
Close Preview when through
Determine What to Print
Click to select either All or Pages to designate that you want to print the Entire
document or only a portion of it. If you click Pages, type the page Number or
arrangement of page numbers (such as 2-5 or 1-10, 15-25) that you want to print.
After selection,
How to Copy
Press Ctrl + C to copy the selection to your document. The original text remains
unchanged in the document. The selected content is copied and held into the
clipboard.
OR
Right click on the highlighted text & choose copy from the menu
How to Cut
Press Ctrl + X. This moves the selected text from its original location to the clipboard.
This option leaves no copy behind.
OR
Right click selected text & choose Cut option
How to paste
Choose location
Press Ctrl + V
A complete Practical Guide to O ‘level A ‘level and Institutions

Page 16

OR
Right click on the location & choose paste option.
Note
The ribbon bar‘s Clipboard section contains the typical Cut, Copy, and Paste
options in case you don‘t want to use the keyboard shortcuts.
Creating a multicolumn news letter
•
•
•
•
•
•

Type your document.
Format your headline
Select the text you want to appear in your columns
Request a section Change
Click your ribbon‘s Page Layout tab and click the Breaks button to display the
available section breaks you can insert.
Select Continuous to convert your selected txt to a new section and make it
reside on the same page as your headline Word adds.

When we add a new story, we want it to begin on a new page. To do this, you can add
breaks.
There are two types of breaks, page breaks and section breaks.
Section breaks allow you to format things like headers and footers differently. For
example, we don‘t want headers on pages with a title, but we do want them on other
pages. Section breaks are ideal for this. If you didn‘t have them, each page would have
the same header.
Steps for section Break
•

Scroll to the end of your first story, and ‗left click on a new line

•

Click on the Page Layout tab at the top of Word. Locate the Page Set up panel
and the Breaks item:

•

Click on Breaks to see the following menu

•

Select Section Breaks > Next Page.

•

This adds a new page to your document, and a new section.

Page breaks and section break
When we add a new story, we want it to begin on a new page. To do this, you can add
breaks.
There are two types of breaks, page breaks and section breaks.
Section breaks allow you to format things like headers and footers differently for
example, we don‘t want headers on pages with a title, but we do want them on other
A complete Practical Guide to O ‘level A ‘level and Institutions
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pages. Section breaks are ideal for this. If you didn‘t have them, each page would have
the same header.
Steps for section breaks.
Scroll to the end of the first story and left click on the new line.
Click on the page layout tab at the top of the word. Locate the page set up panel and
the break item
Click on breaks to see the following menu.
Select section breaks > next page.
This adds a new page to your document and a new section.
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RESOURCE QUESTIONS FOR WORD PROCESSOR
QUESTION 1.
(a) Using Microsoft word, type the passage below as it is and answers the questions
that follow.
―UNESCO hails Uganda”
The Director General of the United Nations Educational, scientific and cultural
Organization (UNESCO), KIOCHIRO Matsuura, has commended Uganda‘s efforts in
emphasizing science Education. Matsuura, who is here for a two-day visit, said on his
arrival at Entebbe Airport yesterday that the UN agency was ―enjoying a strong
bilateral relationship with Uganda.
―We appreciate Uganda‘s efforts in embracing science and cultural education as part
of national development. This being my first official visit here, I hope strengthen the
ties between Uganda and UNESCO‖, Matsuura said.
He emphasized that Uganda‘s cultural and scientific education statistics which stand
as shown in the table below were encouraging by world standards. These statistics
were carried out in the year 2000, 2001, 2002, 2004 for both cultural and science
education.
Cultural education:
Males (%) 70, 50, 28, 40, and 80
Females (%) 60,30,96,48 and 78
Science education:
Males (%) 30,78,90,20 and 60
Females (%) 56,89,76,59 and 90
Females

Males
Year

%

Year

%

Year

%

Year

%

Cultural education

Science Education
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(i)

Set the font size to 13 and double space the document.

(ii)

Copy the document and paste it on the next page.

(iii)

Set the title ―UNESCO‖ hails Uganda to font size 14 and bolded.

(iv)

Set the margins to(1.5) and (1.3 right) then bottom and top (1.2)

(v)

Set the document body text to‘ Arial Narrow‖

(vi)

Insert the header as ―Diploma‖ and in italics

(vii)

Set the whole document to justified and font color, red

(viii)

Number pages in uppercase alphabet.

(ix)

Save your work.

QUESTION 2.
Enter the document below to any word processor available in your
computer.
Computers in business.
Different types of businesses commonly use computers to assist with day-to-day operating activities as:


Sales Order Entry: procedures for handling customer orders, including receipt of the order and
verification of availability of ordered stock.
 Inventory Management and Control: procedures of tracking, counting, and reordering stock
items.
 Personnel Management: procedures for maintaining employee information (such as hire date,
salary, performance rating, and date of last review) for both development and reporting
purposes.
 Payroll: procedures for producing paychecks and reports on employee compensation.
 Accounting: procedures for maintaining the company’s financial records.
 Security: procedures for controlling who has access to what data and information at what times
and where, and who may enter data to a computer-based information system.
 Investment and General Financial Management: procedures a company institutes, follows, and
reviews to guarantee profit and growth.
Computers are also being used in business to collect and analyze data, to produce concise information for
management in a clear format suitable for making decisions, and to help managers avoid being overloaded
with unnecessary information.
To keep up to date with detailed information about how computers are being used in the various
sections of the business and banking world, consult well-known business publications such as Business
Week, Fortune, and The Wall Street Journal, as well as computer publications such as PC World and
Macworld.
Source: Hutchinson, Sarah E. and Sawyer, Stacey C. (1992). Computers The User Perspective, 3rd edition, pg.
31, ISBN– 0-256-10435-2
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Required:
(i)

Change the heading to upper case, bold and underline it.

(ii)

Change the font of the whole document to Tahoma, point size 11 except the
heading which should be point size 15.

(iii)

Add your name as header.

(iv)

Save your file as Computers in Business.

(v)

Print out a hard copy.

QUESTION 3.
(i) Using the suitable word processing software, type this document as it is.
HUMAN BEINGS
Most infants are guided through life by a parent or guardian and taught how to
talk, walk, eat and generally behave. The socialization process begins as soon as
we are born when we being to imitate people around us, copying the shapes and
noises in our environment. Many other people and circumstances affect our
appearance, attitude and behavior, such as work, lifestyle, ethnicity, family,
environment, peer group (friends), gender, media etc.
Human beings are very different throughout the world and opinions of what
constitutes a natural or nurtured human being differ enormously. Without
socialization, an individual would bear little resemblance to any human being
defined as ―normal‖ by the standards of his or her society.
There have been some instances where a person has been deprived of the
assistance of a parent or any other social and human presence. These beings are
often referred to as feral people meaning ―wild‖.
An example of feral people was the Wolf-infants of Midnapore who were reportedly
found in a wolf den in a Bengal forest in 1920. The infants, age two and eight,
walked on all fours, preferred a diet of raw meat, howled like wolves and lacked any
form of speech.
(Adapted from: McKenzie and Bryden (2004:50), Introducing Word 2000 for
Windows)
Further Required
(ii). Copy and paste the document to page 2
(iii). Using the copy on page 2, center, bold and underline the heading and make it
font size 24.
(iv). Center aligns the second paragraph and make it all italics.
(v). Italicize the source of the document and make it font size 8.
(vi). Spell checks your document.
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(vii). Insert your name and index number as footer.
(viii). Save your work as My Work.

QUESTION 4.
(a) (i) Launch a suitable word processing application, typeset the following
document as it appears, save as ―TEEP 2016‖
APPLY FOR THE TEEP 2016 PROGRAMME
Top to form
Welcome to the 2016 edition OF the Tony Elumelu Entrepreneurship
Programme (TEEP), the flagship programme OF The Tony Elumelu Foundofion.
Please note you can save your informofion of any point in the process and
return to complete your saved applicofion before the closing date to complete
your application.
In order to speed up the application process, prepare these documents before
you start your application.
Required
documents
are:
valid government-issued identification
Official
business
official evidence of business ownership
Official
evidence
official
consent
by
(ii)
(iii)
(iv)
(v)

registration
of
partners

certificate

to

directors
apply

Copy and paste the document to page two which you will use to perform
the rest OF the instructions.
Using the copied work on page 2, Centre align the heading, Font size 20.5,
and font style comic sans ms
Apply appropriate bullets on all the required documents for the
application.
Add a hyperlink ―will Run For The Whole Year‖ to the word 2016
PROGRAMME

(vi)

Using a word feature, replace the word of with OF every where it appears
in the document. It should be bold, italics and underlined.

(vii)

Insert a relevant clip art behind the text on page two

(viii)

Insert an end note ―Lets kick out youth unemployment‖ on TEEP found in
the second paragraph.

(ix)

Insert a relevant clip art behind the text on page two

(x)

This clip should be 2cm and 3cm width and height.
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(xi)
(xii)

Add a footer as your name and personal number
Print all your work

QUESTION 5
(a) (i)
Type the following information as it is: (use font size 14)
The time table below will be out by the beginning of next academic year. It
should be copied and filled with relevant subjects.

Senior Four Time table 2010
3:00-4:00

2:00-3:00

LUNCH

11:3012:30

10:3011:30

BREAK

9:0010:00

8:00-9:00

Mon
Tues
Wed

FREE

Thur
Fri
Sat

Note: The outer boarder 4point
(ii)

Put footer as your name and index number.

(ii)

Color ―senior four Time table 2010‖ ―BREAK‖, ―LUNCH‖, and ―FREE‖ green

(iii)
(iv)

Save your work as your name and personal number.
Print your work
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QUESTION 6
(a) Open an appropriate word processing program and prepare the following extracted
document from https://en.wikipedia.org/wiki/2018_FIFA_World_Cup as it appears:
2018 FIFA World Cup
The 2018 FIFA World Cup will be the 21st FIFA World Cup, a quadrennial
international football tournament contested by the men's national teams of the
member

associations

of

FIFA.

It is scheduled to take place in Russia from 14 June to 15 July 2018, after the country
was awarded the hosting rights on 2 December 2010. This will be the first World Cup
ever held in Eastern Europe, and the first held in Europe since 2006,
all but one of the stadium venues are in European Russia, west of the Ural Mountains
to keep travel time manageable.
The final tournament will involve 32 national teams, which include 31 teams
determined through qualifying competitions and the automatically qualified host team.
A total of 64 matches will be played in 12 venues located in 11 cities. The final will
take place on 15 July in Moscow at the Luzhniki Stadium.
The winners will qualify for the 2021 FIFA Confederations Cup.
Host selection
The bidding procedure to host the 2018 and 2022 FIFA World Cups began in January
2009, and national associations had until 2 February 2009 to register their interest.
Initially, nine countries placed bids for the 2018 FIFA World Cup, but Mexico later
withdrew from proceedings, and Indonesia's bid was rejected by FIFA in February
2010 after the Indonesian government failed to submit a letter to support the bid.
During the bidding process, the three remaining non-UEFA nations (Australia, Japan,
and the United States) gradually withdrew from the 2018 bids, and the UEFA nations
were thus ruled out of the 2022 bid. As such, there were eventually four bids for
You are required to:
(i) Create another copy of the same document on page two without retyping.
(ii) Centre align, and underline the heading of the pasted document.
(iii) Apply a picture of football as water mark to the document.
(iv) Design the rest of the document to have 1.5 spacing and justified.
(v) Include Wikipedia, the free encyclopedia as footnotes on the word Luzhniki.
(vi) Provide your personal number and name on the footer.

(vii)

Save your document with your name and personal number.
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(viii)

Print the entire document.

QUESTION 7
a) Key in the following text as it appears using a word processing application of
your choice and save it as ―Internet‖

―Internet‖, ―world wide web‖, and ―web page‖ are no longer the buzzwords
now. They are now a reality. The internet is the world‘s largest computer
network and is referred to as the network of networks. One of the subsets of
the internet is the World Wide Web.
The WWW is based on three mechanisms that are
Used to make resources that is
 Protocols
 Addresses and
 HTML

(i).
(ii).
(iii).
(iv).

Change the drop capped characters to font colored red.
Change text alignment to justify.
At the top of your work, insert a heading, ―the internet‖, centered in font size
18 double underlined and in upper case
Using available word processing application present the following as it
appears.

QUESTION 8
a) Typeset the document below as it is and save your work as computer
performance.
Computer Performance
In order to compare how fast computers can process data, we have to
measure their performance.
There are a number of measurements of performance.
Clock speed, MIPS, FLOPS & Benchmark tests are all used. Some are a better
measure than others.
The table below shows impact of each element on system performance.
Tactic

Effect on Performance

1

Increase clock speed

Increase

2

Increase data bus width

Increase

3

Increase Cache memory

Increase

4

Increase Address Bus

None
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5

Number of processors

Increase

6

Increase RAM

Slight Increase

(b) (i) Format the title as follows. All caps, Center, Bold, and enclose it in a text
boarder.
(ii) Insert a new row between row 4 and 5 and include the item below and
numbering
Increase VRAM

Increase graphics performance

(iii) Change the table color boarder to orange
C. (i) Highlight with a light blue color the word increase wherever it appears in the
document
(ii) Include a header and footer your name and index number respectively
(iii) Include a Hyperlink at the bottom of the page in such a way that allows you to
move at the top when clicked
(d) Print a copy of your work
QUESTION 9.
You are provided with the Science foundation college club time table.
Using a word processor, you are required to produce the below time table exactly
as it appears
DAYS

TIME & GROUP

07:00-

MONDAY

THURSDAY
FRIDAY

8:20-1:00AM

2:00-3:20PM

BREAK

WEDNESDAY

11:50-1:00PM
LUNCH

TUESDAY

MORNING

9:00

1:00-12:30AM

SATURDAY
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a) Feed in the blank time table with club activities of your choice.
b) Make a print out.
QUESTION 10
(a) (i) Using a word processor, type the text below as it is
Do not wish to be anything else, but what you are and try to be that perfect. No
problem can stand the assault of sustained thinking. The worst bankruptcy in the
world is the person who has lost Enthusiasm.
A man‘s success is not how much money he has made, but what kind of family he
has brought up. Luck is what happens when preparation meets opportunities. The
heart of learning is the will to try.
(ii) Copy the text you have typed and paste it below the first copy.
(iii) Format the copied text with double line spacing.
(iv) Insert an auto shape object, fill it with a light colour and order it behind text.
(vi)
(vii)

Draw a thick 6pt line to separate the two copies. Colour the line red.
Insert bullets on the second copy.
(vii) Insert your name, index number and ―©‖ symbol as footer.
(viii) Save and print your work

QUESTION 11
Use Microsoft word processor to write ten letters to ten students of Hodge road
Elementary School for the field trip as below. Note these students have different;
Home addresses, address 1, City, State, Postal Code, and first Name.
Hodge road elementary school
123 Mingo Bluff Road
Knightdale, NC 23456
Wednesday May 1, 1999
<<Home Contact>>
<<Address 1>>
<<City>>, <<State>><<Postal Code>>
Dear<<Home Contact>>:
This is to let you know that on June 3rdwe plan to take <<FIRSTNAME>>‘s class on
a day long Field Trip to the Edison Home in North Fort Myers. The trip will be the
culminating activity after week science unit where the work of Thomas Edison has
been especially a focus of interest for the class.
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<<FIRSTNAME>> will leave and return within the normal time for the school day,
so there will be no disruption to your own schedule.
Please prepare <<FIRSTNAME>> a pack lunch for the trip. The restaurant facilities
at the Edison home are somehow expensive and we have been unable to negotiate
an acceptable reduced charge for school children.
Please feel free to call me at 0776-222235 should you have need to discuss this
matter further. Thank you for your help and support in this endeavor and
throughout the year.
Yours very sincerely,
Donna Hendry.
st
1 Grade teacher

QUESTION 12.
a) Use the word processor of your choice, to produce the document below as it
appears.
ICT AS A TOOL FOR TEACHING AND LEARNING
The term ICT stands for information and communication technology and is defined
as Diverse set of technology tools and resources used to communicate, and to
create, disseminate, store and manage information. ICT has become a very
important part in education delivery and management processes. ICT largely
facilitates the acquisition and absorption of knowledge, and hence can provide
extraordinary opportunities to developing Countries for enhancing the educational
system particularly for the underprivileged constituency, and thereby for raising
the level of quality of life of their people.
a) Copy the document to another page.
b) Double space the space in the document.
c) Italicize and bold the word ICT through the document.
d) Use Times New Roman font face and font size, 12 for the entire document
e) Insert your name and personal number as the footer and header respectively.
Center align them.
f)

Use mail merge feature to post the document to the recipients below.
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Table 1
NAME

ADDRESS

COUNTRY

MS AKIIRO GRACE

P.O BOX 23, KAMPALA

UGANDA

MR. ASSIMWE ANDREW

P.O BOX 19, NAIROBI

KENYA

Mr. CADRE K. NAKIIR

P O BOX 223 DALLAS

TEXUS

MS. KANYARWANDA STELLA

P O BOX 9314

BWEYOGERERE

MR KIBENGE KONKONA

P O BOX 25 KAMPALA

KYAMBOGO

g. Save your work as your name and personal number.
h. Print the work.
QUESTION 13.
Insert the table below
Keith
Beth
Ham
Tim
Val
Kit

45
56
42
63
75
50

86
67
78
95
42
63

85
57
70
67
90
76

a) Apply a border on every cell
b) Insert a row between Ham and Tim
c) Add a column to the right to calculate the totals of students.
d) Insert another row to represent the title for the records as ―Name and Marks‖
e) Merge and centre the last three cells for the title.
f)

Align all the records in the centre.

g) Save your work as your name.
h) Print a copy of your work.
QUESTION 14
a) Type the document shown below exactly as it appears using Word Processor
of your choice. Save the document as trees.
Introduction:
The term ―tree‖ is used in computer science to denote a particular type of abstract
data structure.
Trees contain data in structures called nodes, which are in turn linked to other
nodes in the tree. Every tree has a primary node called a root, from which all other
branch nodes in the tree
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Root node

Figure 5

Leaf node
Descends; In continuance with the botanical naming system, they have no
descendants, these are called nodes.
Why should you use trees?
Primarily, trees are useful for organizing data in a manner that makes it efficient to
retrieve it. To illustrate this, is a picture of collection of data organized in linked list
structure. A binary tree is made up of nodes that can have most two offspring
(children). The root node is the node that is not a child of any other node, and is
found at the top of the tree structure. A node with no children is referred to as a
leaf node. Nodes that are not root nodes or leaf nodes are often referred to as noneleaf nodes.
b) Copy your document to the next page.
c) Apply styles and formatting to the copied document as follows;

i.

i.

Font style to be normal 12

ii.

Font style should be Comic Sans MS

Justify the whole text.

ii.

Chang the color of the whole text to be blue.

iii.

Insert header. The header should be your name.

iv.

Insert page numbers at the centre of the document.

v.

Create a folder on the desktop and rename it under your names

i)

Save your work into the folder in your names.

j)

Make a print out

QUESTION 15
a. Type the document below
How the East Indies got their name.
In 1492, Christopher Columbus, an Italian sailor, sailed from Palos in Spain and
crossed the Atlantic Ocean to the West Indies. He was the first European to set foot
in the new world.
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Long before this time, people in Europe had become interested in exploring the
World outside Europe. In the Thirteenth century, the traveler, Marco Polo had gone
from Italy to china. He even visited. Japan.
Required
b. Bold, centre, underline and apply font size 16 for the heading.
c. Change the heading to upper case.
d. Left indent the first lines of both paragraphs to 1. . .
e. Insert the current date at the top of the documents and right align it.
f. Make a spell check of the whole document.
g. Insert your name and stream as footer, font size‘ 18.
h. Make three copies of your work and create two columns in the passage and add
a footnote as ―our school name‖ on the right hand corner.
i. Apply 1.5 line spacing in your work,
j. Save your work with file name ―Columbus‖ in a folder with your name and class.
k. Print a copy of your work.

QUESTION 16
i) Type the following text as it appears:
HP Launches the First African e-School in Uganda.
Following nearly two years of planning, HP announced plans to launch the
continent‘s first NEPAD e-School at the World Economic Forum Africa Summit in
Cape Town on 1stJune, 2005. Representatives from the, Ugandan Government, the
NEPAD e-Africa commission and HP signed a Memorandum of Understanding on 1
July 2005 in Johannesburg, paving the way for the launch of Bugulumbya
Secondary School, Busobya Village in Kamuli District as the first NEPAD e-School.
On 18th, July 2005, less than two months after launch plans were announced, Flis
Excellency,

President

Yoweri

Museveni

of

Uganda

officially

launched

the

Bugulumbya e-School, attended by approximately 5,000 country officials and
members of the community.
With a staff complement: of 22, including 18 teachers, Bugulumya Secondary
School provides education‘ to around 270 1ners. Set in deep rural Uganda, the
school underwent a radical transformation as a result of the cooperation between
the community, the Ugandan Government, NEPAD and private enterprise. Make the following changes:
i). Change the font of the whole document to size 12.
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ii). Justify the whole document.
iii). Change the line spacing of the whole document to 1.5.
iv). Drop cap the first paragraph and give the letter a blue font color.
v). Insert the table of the musical stars that entertained guests between the
second and third paragraph and align it to the center of the page.
Table 2
Name

Gender

Jose Chameleon

Male

Silvia Kyansunti

Female

Bobi Wine

Male

vii) Insert a merged row at the top of the table and type
“MUSICAL STARS WHO ENTERTAINED GUESTS”.
viii) Auto format the table with a pre-defined design.
ix) Insert a footer containing an Auto text of Page X of Y.
x) Insert a header containing your Index Number and Names.
xi) Insert ® after every occurrence of HP.
xii) Save your work as “Chogam” in a folder CHOGM.

QUESTION 17
Type the document,
Uganda‘s stock exchange is quite nascent with the Uganda securities exchange
(USE) formerly commencing trading in January 1998 of the East African
Development Bank (EADB) bond, another fixed income security, the PTA bank
bond is also being traded on the USE located at the East African Development
Bank (EADB) building in Kampala.
Uganda‘s clays Ltd is the company whose shares were the first to be listed onthe,
stock exchange on January 18, 2000 while a multinational, British American
Tobacco Uganda (BATU) s shares were initially listed on the USE on October 3,
2000.
i.

Justify the whole of the document.

ii.

Make three copies of the document.

iii.

Apply two columns to your document.
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iv.

Drop the first letter of the paragraph.

v.

Shade the first paragraph with color blue.

vi.

Apply a header as your name and your class and stream as the footer.

vii.

Save your work as instructed.

viii.

Print a copy of your work

QUESTION 18.
You have been asked to send acknowledgement letters to people who have so far
made contributions towards the program. The letter contents are the same for all
the persons except the addresses, names, and nature of contributions.
Below is the letter to be sent and a table of people who have made contribution.
NAKIIRS.S.S
P.O.BOX 2333
MBARARA:
14thAug, 2009
[ADDRESS]
Dear [name]
Thank you for your contribution of [NATURE OF CONTRIBUTION) towards the
―funds for food‖ program.
This project is its inaugural year but it has been a resounding success. The
learners and staff agree that it should become an annual event. The principal
would like to thank you and hopes for more support in future.
Thank you very much
……………………………………………..
PRINCIPAL
YUDA TADEO
Table 3
NAME

ADDRESS

NATURE OF CONTRIBUTION

1

Alfonso Miguel

P.O Box 245 Kamuli

$300

2

Lorene Mark

P.O Box 245 Kampala

200,000

3

Alfredo Manuel

P.O Box 731 Kasese

30kg of maize

4

Tim Howard

P.O Box 245 Kamuli

10 bags of rice
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a) Use the appropriate method in any word processing program to make a letter
to be sent to each person in the table.
b) Save your work as your name.
c) Print a copy of your work.

QUESTION 19
Type the text below using a word processing p1gram: choosing word processing
software.
Word processing is using the computer to enter, store, manipulate, and print text
in letters, reports, and books and so on. Once you have used word processing, you
will probably wonder (like million others before you) how in the world you ever
survived without it.
As more word processing packages come on the market, choosing the right software
can become very confusing. Nevertheless, there is probably a word processing
packages that will serve your needs .As you begin looking, ask yourself these
questions:
i. What type of document am I
ii. Now processing?
iii. What types of features do I
Needs?
Want?
Document types can range from simple letters and memos to proposals, reports,
legal documents, books newsletters, scientific papers, form letters, and so on. The
point is matching the features you need with the features in the software packages.
For example, if you, write articles that require references, you will need the
footnoting features; if you develop a newsletter, having the multicolumn layout
feature would superscripts (X2+Y2) and subscripts (A21); and if you send
―personalized‖ form letters the mail-merge feature is a necessity.
A number of add-on programs are available to enhance the functionality of word
processing packages. These include:
On-line thesaurus
Spelling checker
Grammar checker
Style checker
Idea processor (outline)
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What you can do with word processing is limited only by your imagination and
willingness to learn the system. Good luck in your computer-assisted writing
adventures-now and in the future!
(i).
(ii).

Insert the header the word ―Tips‖ on the left hand corner and ―word
processing on the right hand corner.
Bold the heading font size 22 — point underline and centre it.

(iii).

In paragraph starting with the ―document‖ bold the second statement.

(iv).

Make 2 the superscript of X and Y in expressing (X2+Y2) and 21 the
subscripts of A in the expression (A21).

(v).
(vi).

(viii).

Insert bullets on the list of functionality of word processing packages
Insert a footnote of your name on the left and page number on the right and
corner.
Use the appropriate format to replace the word ―notation‖ with the other of
the same meaning.
Indent the whole document by ―0.5‖ to both the left and the right hand side.

(ix).

Insert a clip picture in the middle of the paragraph, which begins with

(vii).

―document‖.
(x).

Save your work under your name.

(xi).

Print and copy your work.

QUESTION 20
Historical images of Apartheid in South Africa
HUMAN RIGHTS.
Apartheid consisted of numerous laws that allowed the ruling white minority in
south Africa to., segregate, exploit and terrorize the vast majority: Africans, mostly,
but also Asians and colored-people of mixed race. In white-ruled South Africa,
black people were denied basic human rights and political rights. Their labor was
exploited, their lives segregated.
Under Apartheid, racist beliefs were enshrined in law and any criticism of the law
was suppressed. Apartheid was racism made law. It was a system dictated in the
minutest detail as to how and where the large black majority would live, work and
die. This system of institutionalized racial discrimination defied the principles of
the United Nations charter and the universal declaration of Human Rights.
In 1976 the United Nations unanimously condemned the elevation of one of the
―homeland‖, Transkei, into an independent state because it remained dependent on
South Africans. Not one country in the world recognized the new state. In 1982
almost one million black South Africans were transferred to another country.
Swaziland……… without their having any say in the matter.
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Ultimately, Blacks demonstrated, held strikes and rioted over such discriminatory
practices.
As a result diplomatic pressure mounted abroad for change. In 1990, Nelson
Mandela, who had devoted his life to democracy, equality and learning for all South
Africans, was released from prison after serving almost 30 years for those beliefs.
He was elected president of the African National Congress the following year, and in
1993 received the Noble peace prize on behalf of all South Africans who suffered
and sacrificed so much to bring peace to their country. On10th, May 1994, Nelson
Mandela was elected South Africa‘s first black president, in that country‘s first
truly democratic election.
Required:
i.

Insert in the header the word of your choice on the left hand corner.

ii.

Bold the heading font size 18 —point, underline, Italy and center it.

iii.

Block indent all paragraphs by 1 inch in the left and right margins.

iv.

In the fourth paragraphs starting with On may bold the second sentence

v.

Make the body font size to 13 and foot style to Anal.

vi.

Justify your work.

vii.

Create two columns in the passage and a footnote of your school and
name on the right corner.

viii.

Save the work as your name and make a printout.

QUESTION 21
Typeset the text below using a word processing program:
ON DECISION TO BUY
The members of the Exchange require that forward payment for shares be made to
reduce defaults. On making the buying order, the client will fill in client
information, an order form and sign a purchase transfer form and then pay for the
number of shares he/she is willing to buy and the broker will issue him/her with a
receipt. On the day the order is executed at the exchange, the broker then will send
his/her buying client a purchase contract note showing the number of shares
purchased, the price per share and the commission chargeable. A purchase
contract note is a legal document that acts as proof of ownership until the share
certificate arrives therefore it must be kept safely.
At the same time, the broker forwards the signed purchase Transfer Form to the
registrar through the exchange. The registrar upon receiving your transfer form
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through your broker issues a new certificate in your name via the same broker.
This certificate is a legal document confirming ownership and should be kept
safely.
i).
ii).

Set the page margin to ―1.5‖ to the left and right of the document.
Apply a header to the document which should among others have a name
of the company in word art, address, logo and lines

iii).

Apply ―1.5‖ line spacing to your work.

iv).

Drop the first letter on each paragraph.

v).

Capitalize the title format it accordingly.

vi).

Save your work and make a printout.

QUESTION 22.
Use Microsoft word to the records be1ow
Table 4
NAME

ADDRESS

NATURE OF CONTRIBUTION

1

Alfonso

34

KAMPALA

2

Lorene Mark

12

MBARARA

3

Alfredo Manuel

45

MBALE

4

Tim Howard

54

GULU

a. Apply 3 line boarders on the table.
b. Bold and capitalize the titles.
c. Insert three rows below and enter records of your choice.
d. Sort the names in ascending order.
e. Split the column for Lorena and enter another name.
f. Split the row for Tim and enter another record.
g. Insert a row at the beginning, merge it and key the title for the table
h. Make print out of your work.

QUESTION 23
Make a headed paper of your company
i.

The header should include among others, the name of the company, address
(box number, email address, phone number and fax) and date.

NB: the name of the company should be done in word art
ii.

Apply a logo of the company in the header.
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iii.

Make the company‘s Motto as the footer.

iv.

Apply a line at the header and footer with 4Y3 line style

v.

In the normal view, list-down the products or services offered by your
company.

QUESTION 24
Construct the table below and answer the questions that follow
Table 5
Particulars

Quantity

Price

Dry cells

30

120,000

Threads

15

12,000

Connecting wires

27

15,000

Resistance wires (SWG 28)

27

20,000

Torches

4

18,000

Ammeters

50

20,000

Voltmeter

50

20,000

Bulb holders

50

2,000

Cell holders (single)

100

4,000

Concave mirror (f10)

40

5,000

Concave mirrors (f15)

40

5,000

a) Insert a column before particulars to number the particulars.
b) Insert a column after price and calculate the amount
c) Delete the rows for torches and bulb holders:
d) Insert a row at the bottom to calculate the amount of the products.
e) Make row height ―0.3‖.
f)

Save your work and make a print out.

QUESTION 25
Type the following text exactly as it is and follows the steps as will be indicated in
the text below:
a) It‘s the answer spoken by young and old, rich and poor, democrat and republic,
black, white, Latino, Asian, Native American, gay, straight, disabled Americans who
sent a message to the world that we have never been a collection of Red States and
Blue states: we are always will be, the United States Of America.
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b) It‘s the answer that led those who have been told for so long by so many to be
Cynical, and fearful, and doubtful or what we can achieve to put their hands on the
arc of history and bend it once more towards the hope of a better day.
c) It‘s been a long time coming, but tonight, because of what we did on this day, in
this election, at this defining moment, change has come to America.
Required:
(a) Insert a header of your document to be ―Barrack Obama victory speech‖ in the
centre and the footer to ―change has come to America‖. This should be at the right
hand corner.
(b) Insert a foot note ―change for the better‖
(c) Drop the first letter to cover 2 lines
(d) Save your work and make a printout
QUESTION 26
You have been asked to send invitation letters to people to be invited for your
graduation party. The letter contents are the same for all the persons except the
address, names and pledge.
Below is the letter to be sent and a table of people and their pledge.
St. Anthony Rest.
P.O.Box 8125,
Kampala
23rd July 2009
[TITLE]
Dear [NAME]
You are invited to attend a wedding ceremony of Salvador Sorenza and Isabelle
royal scheduled to take place at St. Anthony restaurant and take away, Buganda
road
Please don‘t forget your pledge of [PLEDGE]
We shall be grateful if our invitation is honored.
Thanks,
Yours truly,
……………………………………………………
ANDRE CORONA
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Below are the pledges.
Table 6
Name

Address

Pledge

1

Rosette

Bugolobi

Cake

2

Keith

Kasubi

Wine

3

Hyde

Kitintale

Bride shoe

4

Hearte

Bunga

Gifts

5

Reina

Mutungo

Gown

a) Use the appropriate method in any word processing program to make a letter
to be sent to each person in the table.
b) Save your work as your name and make a printout.
QUESTION 27
Using Microsoft word, type the statements below and answer questions that follow.
IRR analysis is generally used to evaluate the projects cash flows, rather than the
income from the project that would be shown on an income statement. (Also known
as the profit and loss statement) Why? Because income on a P&L reflects
depreciation, but depreciation is not an out-of-pocket expense. For instance, if
revenue of $10,000 is reduced to $7000 of income because of a $3000 depreciation
deduction, you still have the use of the full $10,000. So the cash flow figure of
$10,000 is usually the more instructive one to look at. However, if you are very
concerned about the appearance of your income statement (for example, if you
anticipate putting the business up for sale or seeking major financing in the future,
or if you are under stockholder pressure for increased income) you may decide that
the income figure is more appropriate to use.
How do you compute the IRR? The easiest way to use a good financial calculator. If
you have one, or don‘t want to take the time to learn to use one, you can also use
the present value tables located in Business Tools.
Required:
i.

Apply line spacing of 0.5 to the document.

ii.

Justify your work to look orderly.

iii.

Make a copy of the document and paste to another page.

iv.

In the first paragraph, shade the first sentence with color blue.

v.

Indent your work by 0.5 to the left and the right. —

vi.

Save your work as investment ‗and make a printout.
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QUESTION 28
Using Microsoft, type the statements bellow exactly as they are and answer the
questions that follow.
Tips for financing a Major Purchase
Don‘t fall for expensive service contracts. Service contracts that are pitched to you
when you buy a piece of business equipment are often a good deal for the supplier
but not for you. In most cases, the amounts you would spend on a service contract
is wasted money. This is especially true in the case of generic equipment that
normally carries a warranty any way if something is going to go wrong, it will
generally do so in the first 30 to 60 days, when your warranty should cover the
problem.
There may be situations where service contracts are a good deal. For example, if
the equipment was custom-built and expected to need regular maintenance in the
future, if spare parts and knowledgeable labor will be hard to find, or if getting
repairs done immediately is extremely important to your business‘s operation, you
might decide to purchase a service contract on a trial basis.
Compare the NPV of the loan payments. If you have decided to purchase a major
asset and are planning to take out a loan, a good way to compare the options
available is to do a net present value analysis of your cash flows under the various
interest rates and terms your local leaders have available. Your cash flow
projections should consider the loan payment out flows as well as their venue
inflows that would result from your purchase or projects.
Required:
a) Format the title to, font size 18, centered, bolded with upper case.
b) Justify the statements.
c) Drop the first letters of the paragraph.
d) Format your work to be double spaced.
e) Apply two columns to your document.
f)

Save your work as your name

QUESTION 29
Use of DDT welcome
Malaria is the biggest health problem in Uganda and in general, Africa. Its toll in
Africa is the heaviest yearly. Ninety percent of malaria deaths occur in Africa. It is
responsible for over 300 million cases of accurate illness each year leading to
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deaths. On the economic front, malaria costs Africa more than $12 billion
annually. It has slowed economic growth in Africa countries by 1.3% per year. Had
the disease been wiped out decades ago, $100 billion would have been added to
sub Saharan Africa‘s current GDP of $300 billion this year.
Malaria transmission occurs by mosquitoes moving to houses, entering during the
early evening resting indoors and, at some point during the night, landing on
humans and biting. During the act of biting the mosquitoes might acquiremalaria
parasites and become infected, or if already infected, they might transmit malaria
to another human.
DDT residues on house on house walls can alter this sequence of mosquito
behavior.
The non-contact repellent action of DDT residues can prevent a malaria mosquito
from entering a house. If the mosquito enters, in spite of repellent action, then the
contact irritant action might cause it to exit before biting. If the contact irritant
action falls then contact toxicity might still result in mosquito death, after
prolonged contact with DDT - treated surfaces.
Required
i.
ii.

Using a suitable word processor, type the above document.
Embold the title using Arial font type with size 14.

iii.

Ensure the rest of the document is in Times News Romans, size 12

iv.

Include a Header ―DDT‖ and Footer with a left adjusted value for ―today‘s
date‖ and a right adjusted ―page number‖.

v.

Ensure both the top and bottom margins are set at 1.1‖ while both left and
right margins are 1.25‖

vi.

Replace every occurrence of the word DDT, except in the title, with
―dichlorodiphenyl trichloethane‖

vii.

Save document as ―pre-mock word processing‖ on the floppy provided

QUESTION 30
(a) Type the text below using air-appropriate word processing program.
The Storks and the Urchin
Of all the boys in the town, the most forward in singing nonsensical verse was
always the same one who had begun teasing the storks, a little urchin not more
than six years old. The young storks, indeed, fancied him a hundred years old,
because he was bigger than either their father or mother and what should they
know about the ages of children, or grown-up human beings!
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All their schemes of ravage were aimed at this little boy; he had been the first to
tease them, and had been the first tease them, and he teased them still.
The young storks were highly excited about it, and the older they grew the lessthey
were inclined to endure persecution. Their mother, in order to pacify them, at last
promised that they should be revenged, but not until the last dayof their stay in
that place. Hans Christian Andersen
(b) Copy and paste this document to the next page.
(c) Change the heading to upper case, font comic sans ms, underline it with any
dotted line and a font size 13.
(d) Justify the whole document
(e) Change the line spacing for paragraph one to 1.5.
(f) Drop cap on two lines the letter beginning paragraph one.
(g) Create a footnote on the word ―pacify‖ and it should have the statement ―to calm
somebody who is angry‖.
(h) Your name and personal number should appear as footer and in italics.
(i) The name ―Hans Christian Andersen‖ should be crossed through.
(j) Highlight the word ―scheme‖ with color yellow.
(k) Save this document as ―prose‖.
(l) Print your work.

QUESTION 31
(a) Using a word processing application of your choice typeset the following text as
it appears and save as „flow chart”
A Data Flow Diagram (DFD) is a graphical representation of the ―flow of data
through an information system, modeling its process aspects. A DFD is often used
as a preliminary step to create an overview of the system, which can later be
elaborated.
In the late 1970s data-flow diagrams (DFDs) were introduced and popularized for
structured analysis and design. DFDs show the flow of data from external entities
into the system, they showed how data moved from one process to another, as well
as its logical storage.
There are only four symbols:
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(i) Squares representing external entities, which are sources or destinations of
data.
(ii) Rounded rectangles representing processes, which take data as input, do
something to it, and output it.
(iii) Arrows representing the data flows, which can either, be electronic data or
physical items.
(iv) Open-ended rectangles representing data stores, including electronic stores
such as databases or XML files and physical stores such as or filing cabinets
or stacks of paper.
Below is a sample of a data flow chart showing what happens when you make a
phone call.
Phone call is placed

Is ringer turned on
N
Y
Voice mail picks up

Phone rings

N

Does user answer
phone

Y

N

Is ring #
4

Y

Figure 6

Phone call complete

(b) Present your work on an A4 paper size, margin dimensions as 2cm top, bottom,
left and right respectively.
(c) Insert a heading DATA FLOW CHART
(d) Centre the heading, bold and apply a text boarder.
(e) Group your diagram to appear as one image
(f) Include a hyperlink .in such a way that when you click, it takes you to the top of
the document.
(g) Include a text water mark as your subject combination
(h) Add a caption to appear at the bottom of your flow chart to read ―Phonecall flow
chart‖.
(i) Italicize the word ‗data‘ wherever it appears and change it to color Blue.
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(j) Include your Header and footer as your Name and Index Number
(k) Print a copy of work

QUESTION 32
a) Using available word processing application to type the following as is. Save this
file as remote workers in a folder.
Six Reasons Remote Workers Are Good for Business
Inc.com, May 11
When it comes to workplace flexibility, allowing employees to work from somewhere
other than the office, or at times other than from 9 to 5, can make a big difference
in both productivity and worker retention. Simply put, working remotely is good for
the bottom line on several levels: remote workers are more productive, stay longer,
and report higher levels of happiness. Office distractions aside, not having to deal
with the friction of simply getting into the office is huge for some employees who
are less stressed not having to commute.
In terms of worker productivity, a recent Stanford study found call centre workers
working from home outperformed peers in the office because they took shorter
breaks and used fewer sick leaves. They also reported higher levels of happiness
and quit less often. However, some workers didn‘t do as well at home due to
loneliness so it‘s important to make sure remote work is a good fit according to
each employee‘s personality. A Gallup study found that not only do remote workers
log more hours, but also they‘re slightly more engaged than their office
counterparts. Specifically, the research showed people who worked remotely part
time were the most engaged due to their ability to enjoy the best of both worlds-the
opportunity to have in-person relationships with others in the office, while also
being able to reap the benefits of working from home, such as fewer distractions.
Remote workers are less stressed and happier to contribute, making them more
loyal to the company. The reasons are:
Table 7.


Remote workers are more productive and stick around longer



Employees who work from home are more engaged



Remote workers are less stressed



You save money on real estate and utilities



You hire from a wider talent pool



You can reduce your carbon footprint

A complete Practical Guide to O ‘level A ‘level and Institutions

Page 45

c) Copy the work from page 1 and paste it into page 2.
d) Insert the page number as page X of Y.
e) Make page 2 layouts to be in landscape form only.
f) Justify your work and insert footnote on the last paragraph: BYCHRISTINA
BESMARAIS Contributor, Inc.com
g) On page 1, make left and right indentation 6 mm and 17 mm respectively on
paragraph one only.
h) For the title, remove the underlining, bold the title and make it uppercase. .
i) Make a drop cap as ‗dropped‘ in the first paragraph with orange font colour
j) Print the entire file remote worker
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POWER POINT
(ELECTRONIC PRESENTATION)
A presentation program is computer program/application software that is used to
display information normally inform of a slide show.
It is important to note that communicating effectively to bigger audiences is a
challenge to many people. However, the versatility of ICTs has played a big role in
enhancing the ease and impact of the presentation process.
Therefore, presentation program helps the presenter with a wide range of tools to
clearly structure his ideas and offer the participants with multimodal information
that is so engaging.
There are many areas where power point can be used, these include;
a. Professional education. (work-related)
b. Entertainment.
c. General communication.
Presentation programs can either supplement or replace the use of older visual aid
technology, such as pamphlets, handouts, chalkboards, flip charts, posters, slides
and overhead transparencies.
A presentation program (power point) typically includes three major functions i.e.
i.

An Editor that allows texts to be inserted and formatted.

ii.

A Method majorly for inserting and manipulating graphic images.

iii.

A Slide show that is a system to display the content.

Examples of presentation packages/software include the following;


Microsoft power point



Harvard graphics.



Open office presentation



Coral presentation



Lotus freelance graphics



Keynote.

With presentation, texts, audios, graphics, movies and other objects are positioned
on individual pages or slides in a given presentation.
Starting Microsoft PowerPoint.
To start Microsoft PowerPoint,
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Point on the taskbar,
Click Start and then
Point to All Programs
Click Microsoft office, then you can select Microsoft office PowerPoint, a Microsoft
power point window will appear.
To create a slide/Title Slide
Write in the boxes as displayed in the default slide layout.
OR
Change to blank slide layout and use text boxes and have greater flexibility in
where you want working in different view modes:
Terms used in PowerPoint.
Slide views.
1. Slide Sorter: a window that arranges all slides in one screen in horizontal
rows. This kind of view is useful to make changes to several slides at a time.
Slides can also be re-arranged in any order. Changes may include;
Rearranging,
Deleting, moving,
Copying among others. All these are important in a slide sorter view.
2. Normal View: it can also be called a slide view. A single slide and can add text,
delete or modify the slide contents. It is the main working window in the
presentation. The slide is shown full size on the screen.
3 Notes Page View: Allows one to view the Notes Pane better add and modify
additional notes to a selected slide. Our text placed on the slide.
Other terminologies used in PowerPoint presentation.
4. Design temperate: This is a co-ordinate packaged deal. It is created so that
even though different slide types can have different layouts and graphics, the whole
presentation goes together as an attractive package.
5. Transition: Slide transmissions are visual movements as one slide changes
another.
6. Animation and animation schemes: these are visual effects applied to
individual items on the slide such as graphics, tittles or even bullet point.
7. Slide master: this is a default design temperate/parent slide template which
other child slides by default take it‘s formatting. All slides in a presentation are
designed using the font colors and styles and graphics in a slide master.
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8. Ribbon: This is a strip of buttons across the top of the main window.
Multimedia in PowerPoint.
This is both audio/sound, video and pictures but in motion/movement state.
9. Video/movies clips: Video clips are added to enhance your presentation. This
can show authentication, movement or simulated movement, which makes the
presentation more interesting. Movement is either by click of the mouse or
automatic.
10. Hyperlinks.
A hyperlink is an element in an electronic document that links/leads you to
another place in the same document or to an entirely different document. Typically,
you click on the hyperlink to follow the link. Hyperlinks are the most essential
ingredients of all hypertext systems, including the World Wide Web.
11. Sound.
Sound as with video or movie clips, is added to enhance your presentation. If for
example your presentation is about weather, as sound clip of thunder can be
added. Clicking on the sound clip will activate the sound.
RESOURCE QUESTIONS FOR POWERPOINT
(ELECTRONIC PRESENTATION).
QUESTION 1
The four ―Categories of Computer Hardware‖ are input, storage, processing,
and output.
Required
Create a Presentation as indicated below:
(i)
(ii)
(iii)
(iv)
(v)
(vi)
(vii)
(viii)

Slide One – Include the Title, your name, class and email address
(if applicable).
Slide Two Introduction notes to hardware and types of computer
hardware.
Slide Three – Outline Input Hardware.
Slide four – Outline Storage Hardware and Processing Hardware
Slide Five – Outline. Output Hardware.
Insert six numbers in your presentation.
Save the Presentation as Computer Hardware.
Print your Slides.
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Note The




slides should:
Link to one another with action buttons.
Use minimal graphic effect.
Have your name and class as footer.

QUESTION 2
The three ―Categories of Computer Software‖ are Operating System,
Application Software and Utility Software.
Required
Create a Presentation as indicated below:
(i)

Slide One – Include the Title, your name, class and email address (if
applicable).
(ii)
Slide Two – Define the Operating System and give at least two
examples.
(iii)
Slide Three – Define Application Software and give two examples.
Slide Four – Define Utility Software. Give two examples.
(iv)
Slide Five – Your conclusion.
(v)
Insert slide numbers in your presentation.
(vi)
Save the Presentation as Computer Software.
(vii)
Print your Slides.
Note The slides should:
a.
b.
c.

Run automatically.
Use minimal graphic effect.
Have your name and class as footer

QUESTION 2
You have been appointed a Public Relations Officer in the Ministry OF Information
and Technology. Prepare a manually running presentation to be used to address
the workshop OF ICT Teachers Introducing them to new changes in examining
Computer studies in all Secondary Schools across the Country.
Slide one:
Introduction:
Title and name OF the presenter
Slide two:
Aims OF teaching Computer studies
Should include Aims OF teaching computer studies to students
in secondary schools.
Slide three:
Topics to be examined in Section C OF Paper 1.
Insert the table below to show how each stage can be prevented
SN
01
02
03
04

TOPIC
Elementary Programming
principles
Computer Hardware
Communication
Networking
System
Start

up

EXAM SECTION
Section C

MARKS
20

Section C

20

and Section C

20

and Section C

20
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05

Configuration
Trends in Computing

Section C

20

Slide four:
Challenges OF teaching computer studies.
Should include why it is becoming hard to teach computer studies.
Slide five: Solutions to the above challenges
Tasks:
a. Prepare a five slide presentation for use in your talk should manually run.
b. Use minimal transitions and animations.
c. With use OF slide master, In the footer section,
 Insert your random number in the right Corner.
 Automatic slide numbers on the left.
 automatic date and time in the center
d. Use a simple background theme colour.
e. Add a Tabular slide to analyse the content in the table above
f. Each slide must contain an action button to the first slide
g. Use relevant graphics on every slide.
h. Save your presentation as “changes”.
i.

Print a handout OF all slides scaled to one page

QUESTION 3
As an experienced student of computer studies, you have been appointed by
your teacher to go and talk to the new S.Is about the subject called computer
Club on their first careers day in the orientation week. The topic is “ICT
Club”.
(a) Prepare a five slide presentation to deliver your content to the senior
ones considering the following;
(i) Slide one is a title slide and the Topic and presenter‘s details.
(ii) Slide two contains a description of ICT Club at your school.
(iii) Slide three should have key benefits of being a member of the ICT club
and what is expected from new members.
(iv) Slide four should have the challenges the club faces and the way forward
(v) Design the fifth Slide with concluding remarks.
(b)

Let your slides have a fly-in transition affect from top left corner.

(c) The slides should be able to loop continuously until escape key is
pressed.
(d) Apply appropriate background color of your choices.
(e) Insert an action button to link all slides to the next slide.
(f) Insert the current date and your name as your footer
(g) Save your presentation with your ―index number‖
(h) Print all the five slides on handout.
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QUESTION 4
Ministry of Education and Sports is rolling out a sensitization projects named:
―COMPUTER STUDIES FOR ALL‖. You have been appointed to prepare a four
slide presentation saved as ‗ICT‘ including the following details:
Slide 1:

To include the topic for discussion ―Computer Studies for all‖, include
your name as a presenter.

Slide 2:

To include advantages of computer literacy. Write seven (7) ordered
advantages of obtaining computer literacy in Uganda.

Slide 3:

To include possible challenges to achieving computer literacy for all.
Write about 7 numbered points.

Slide 4:

To include a conclusion to your discussion.

QUESTION 5
You are required to make a presentation to a group of web design
Students about the following multimedia features, namely
(i) Video.
(ii) Hyperlink.
(iii) Sound.
Include the following information about each of the components
(a) Create a presentation in which each concept (i) (ii) and (iii) is on its own Slide.
Enhance with a graphic of your choice.
(b) The first slide should contain links through action buttons to each other Slide.
Note: Each slide must contain a link to the first slide, through an action button.
(c) Include your name and index number on each slide and save your work. (d)
Print your slides.

QUESTION 6
Create a suitable 6 - slide show presentation for the advert of your favorite artist
who is going to stage a, show at national theatre with the following items:
(Remember it‘s a television advert)
The slides should have the following:
(i) Appropriate animation schemes to view the presentation.
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(ii) Appropriate transition for the show
(iii) Clips and word art where applicable
(iv) Appropriate design templates and back ground color
(v) Apply sound where possible to enhance your presentation
(vi) Footer bearing your name and, index number
(a) A suitable title for the show
(b) The date and time the show will feature Location of the theatre
(c) Other artists to feature in the show.
(d) Save your work and make a printout
QUESTION 7
Road accidents are very rampant in Uganda. Many people have lost their lives in
road accidents. You are required, using presentation software to educate Ugandans
about road accidents. Create four slides indicated in parts (i)-(iv).


Every slide should:



Use minimal graphical effects to make the presentation entertaining. a Be
able to convey the appropriate message to the community



Run with a click of the mouse



Apply sound where necessary to enhance your presentation



Have your name and index number as footer.

(i) Slide I - should include the title, your name and your school name
(ii) Slide II - should include the actual causes of road accidents in Uganda.
(iii) Slide III - Should include the contribution of traffic police in the prevention of
road accidents.
(iv) Slide- Should the preliminary precautions to avoid road accidents.
(v) Save the presentation as ―Road accidents‖.
(vi) Make a printout of your work

QUESTION 8
Pollution is becoming rampant and a problem in Uganda and the whole World at
large. You are required, using presentation software to educate Ugandans about
pollution. Create four slides as indicated in parts (i)-(iv). Every slide should:
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a) Use minimal graphical effects to make the presentation entertaining.
b) Be able to convey the appropriate message to the community.
c) Run with a click on the mouse.
d) Apply sound where necessary to enhance your presentation.
e) Have your name and index number as footer.
(i) Side I - Should include a suitable title for your presentation.
(ii) Slide II - Should include the different types of pollution.
(iii)Slide III - Should include the general causes of pollution.
(iv) Slide IV - Should include the effects, and problems of pollution to the
environment.
(v) Slide V - Should include the solutions to the problems.
(vi) Save the presentations as ―Pollution‖.
(vii) Make a printout of your work.
QUESTION 9
Agriculture is one of the leading income generating activities in Uganda but its
growth has been hindered by many factors including soil erosion. You are required,
using presentation software to educate Ugandans about soil erosion. Create four
slides as indicated in parts (i) - (iv). Every slide should:
a) Use minimal graphical effects to make the presentation entertaining.
b) Be able to convey the appropriate message to the community
c) Run with a click of the mouse
d) Have your name and index number as footer.
(i) Slide I - Should include a suitable title for your presentation
(ii) Slide II - Should include the definition for soil erosion and various types of soil
erosion
(iii) Slide in - should include the causes and effects of soil erosion
(iv) Slide IV - should include the solutions to the problems
(v) Save the presentation as ―Soil erosion‖.
(vi) Make a printout of your work
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QUESTION 10
Create a suitable 6 - slide show presentation for the wild life & Environment club of
the parish with the following items:
The slides should have the following:
(i) Appropriate animation schemes to view the presentation.
(ii) Appropriate transition for the show.
(iii) Clips and word art where applicable.
(iv) Appropriate design templates and back ground color.
(v) Footer bearing tour name and index number.
(a) A text slide with the name of the club.
(b) A text slide with the departments of the club.
(C) A text slide with the activities in the club.
(d) A two column text slide with the names of the workers in the club.
(e) A text slide with other related activities in the club.
(f) A tabular slide with fifteen imaginary volunteers with their imaginary annual
subscription payments.
(g) A column chart for analyzing the highest payments per individual member.
(h) Save your work as your name and index number.
(i) Print your slides.
QUESTION 11
Create a suitable 6 - slide show presentation for the networking essentials with the
following items:
The slides should have the following:
(i) Appropriate animation schemes to view the presentation.
(ii) Appropriate transition for the show.
(iii) Clips and word art where applicable.
(iv) Appropriate design templates and background color.
(v) Footer bearing your name and index number.
(a)A title for the slide —
(b) Definition of networking
(c) Types of networking
(d) Types of networking processes
A complete Practical Guide to O ‘level A ‘level and Institutions

Page 55

(e) Networking tools
() Types of network cables
(g) Advantages and disadvantages of networking
(h) Save your work and make a printout.
QUESTION 12
A telecommunication Company MTN has appointed you a marketing officer.
You are required to give a talk on ―MTN the Better Connection‖
(a) Design 4 slides as follows:
(i) Slide I should have the introduction of the topic.
(ii) Slide II should have the content of the topic.
(iii) Slide III should show the advantages over its competitors.
(iv) Slide IV should show the future plan of MTN.
b) Use different preset backgrounds for each slide.
c) Include your name and index number at the end of each slide.
d) Apply minimal animations.
e) Save your work as ―MTN‖.
f)

Make a printout of work

QUESTION 13
As a forest officer in your home district, you have been‘ assigned a project to
sensitize people in your locality about the importance of education.
You are required to design four slides.
a) Slide I: Introduction (include definition of forestry)
b) Slide II: Content (types of forests)
c) Slide III: Introduction (include definition of forestry)
d) Slide IV: Content (types of forests)
e) Slide V: benefits arid achievements of forests.
f) Slide VI: Shortcomings of forests and conclusion.
g) Save your presentation as FORESTS.
(i) Set your slides to have suitable back grounds
(ii) Include your name, index number on each slide as a footer.
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(iii) Set the slides run automatically.
(iv) Insert a graphic on each slide
QUESTION 14
A Ugandan group is interested in your presentation skills to communicate an idea
to the government about the need to conserve the forests.
You are required to:
a) Create four slides:


Slide one should have the introduction of the topic.



Slide two should represent the Group members‘ names, Addresses,
telephone contacts, occupations.



Slide three should represent the benefits of the forests.



Slide four should represent the conservation methods.

b) The presentation should have a continuous loop.
c) Use minimal appropriate graphics and designs
d) Creativity S
e) Include the following on each slide:
 Your name
 Index number
 Current date


Current time



Save your work on a diskette and name it ―Forests‖.

QUESTION 15
Create a presentation of not less than 3- pages about your school.
a. The slides should be able to run continuously without external intervention.
b. The slides should have appropriate but minimal graphics.
c. Create a folder ―section 2‖ on the floppy (diskette) provided
d. Save your work in folder section 2 End of term I PRESENTATION 2
e. Make a print out.
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QUESTION 16
You are required to prepare a project of 4 slides on CAUSES OF HIV AMONG THE
YOUTH IN UGANDA.
(i)

The first slide should be your topic, presenters name and school.

(ii)

Format all your title slides (headings) to ―Algerian‖ Font style.

(iii) Insert a relevant and different back ground on each of the slide.
(iv)

Insert a ―dissolver transition to run automatically every after 5 seconds.

(v)

Your project should have at least an image.

(vi)

Add an animation ―exit blinds ―on all your slides.

(vii) Save your work in your folder on the desktop.
(viii) Print out
QUESTION 17
You are required to prepare a project of 4 slides on WHY SECONDARY STUDENT
HAVE FAILED TO PASS EXAMS.
(i) The first slide should be your topic, presenters name and school.
(ii) Format all your title slides (headings) to ―Algerian‖ Font style.
(iii) Insert a relevant and different back ground on each of the slide.
(iv) Insert a ―dissolve‖ transition to run automatically every after 5 seconds.
(v) Your project should have at least an image.
(vi) Add an animation ―exit blinds ―on all your slides.
(vii) Save your work in your folder on the desktop.
(viii)Print out
QUESTION 18
You are required to prepare a project of4 slides on Causes of road accidents in
Uganda today.
(i) The first slide should be your topic, presenters name and school.
(ii) Format all your title slides (headings) to. ―Algerian‖ Font style.
(iii) Insert a relevant and different back ground on each of the slides.
(iv) Insert a ―dissolve‖ transition to run automatically every after 5 seconds. Your
project should have at least an image.
(v) Add an animation ―exit blinds ―on all your slides.
(vi) Save your work in your folder on the desktop.
(vii) Printout
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QUESTION 19
You are required to prepare a project of 4 slides on MEASURES ON HOW TO
CONSERVE THE ENVIRONMENT
(i) The first slide should be your topic, presenters name and school.
(ii) ii, Format all your title slides (headings) to ―Algerian‖ Font style.
(iii) Insert a relevant and different back ground on each of the slide.
(iv) -. Insert a ―dissolve‖ transition to run automatically every after 5 seconds.
(v) Your project should have at least an image.
(vi) Add an animation ―exit blinds ―on all your slides.
(vii) Save your work in your folder on the desktop.
(viii)Print out.
QUESTION 20
a) Create a five - slide presentation about the introduction of subsidiary
Information and Communication Technology (ICT) for A-level in Uganda. In your
presentation do the following:
(i) Slide I- Include the title ―Report on the Introduction of Subsidiary ICT‖.
(ii) Slide II - State reasons why Subsidiary ICT was introduced in Uganda.
(iii) Slide III - Give the expected outcomes of studying Subsidiary ICT.
(iv) Slide IV — List problems that are faced in schools offering SubsidiaryICT.
(v) Slide V — Make a conclusion thanking the Ministry of Education, Science,
Technology and Sports for introducing Subsidiary ICT to the curriculum of
Uganda.
b) Use appropriate transition for your slides.
c) Use appropriate animation schemes to view your presentation.
d) Rehearse time your presentation with an appropriate timing of your choice.
e) Loop your presentation continuously.
I) On the title slide apply a clip art of the picture of a computer.
g) The title should have the font size of 43.9, and it should appear different / from
the other slides.
h) All the slides should bear a footer of your name and personal number except the
title slide.
1) Apply appropriate colors for each slide.
j) Save your work as your name and personal number.
k) Print your work.
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QUESTION 21
Assume that you are working as a Relation Officer in one of the leading Hotels in
Uganda. Make a five-slide presentation with relevant data about the major areas
you would focus on while campaigning to market the products in your Hotel to
consumers or customers. Suggest an appropriate title to this advertisement.
In additional, show the following on all your slides:
(i)

Pleasant text colors and background.

(ii) Footer as your name and today‘s date in all slides.
(iii) Images, sound and video.
(iv) Automated animations and transition schemes.
(v) Buttons for navigation to and fro slides.
(c) Save the as your name and print all slides on a page

QUESTION 22
The School Nurse is planning a student‘s workshop shortly this month. He has
requested you to prepare a presentation entitled Typhoid with the following subheading.
Instructions:
a) Insert one slide (Slide one) to contain a title: Typhoid. On this slide, write your
name as a presenter. Lay out your text to create better slide usage. You are free to
vary-the font sizes.
b) Insert a slide (Slide two) to contain a title: How Typhoid is spread. On this slide,
list five possible causes of Typhoid. This list should be ordered
c) On slide three, provide a title: Symptoms of Typhoid outbreak in an environment
d) On slide four, mention the ways of preventing Typhoid outbreak in an
environment
Provide for the following.
e) Insert relevant graphics and simple background
1) Use today‘s date and time on each slide. (It should update automatically
g) Include slide numbers
h) Re arrange slide such that slide 3 comes first than slide two
i) Entry animation of diamond for the first three slides and fly in for the last slide
j) Loop your slides.
k) Save your work as ‗Typhoid‘.
l) Print a copy of your work.
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QUESTION 23
Make a three page presentation for your school dealing with computer training.
(i) Find a template (background) which is appropriate for this presentation and
use it.
(ii) Use your school name as the title on all three pages in this presentation.
(iii) Type the following text in the first page. The schools postal addresses and its
e-mail address.
(iv) Use different font sizes to make it look neat.
(v) Type the following in page two.


Computer classroom training



CD self study



IT training consultancy.

(vi) Use bullets, according to the number of lines in the text and lay out the
pages to make it easy to read.
(vii) Create a slide show and save it with an appropriate name.
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QUESTION 24
As health educationist, you are required to make five slides for the community.
This is to be presented in form of a slide show on health.
a. Create a presentation on the topic “Malaria”


Slide I should contain the introduction and presenter.



Slide II should contain the body and introduction.



Slide III three should contain how Malaria is caused and spread.



Slide IV should contain control measures



Slide V should contain the conclusions.

b. Use minimal effects in the slide. This should make the presentation entertaining.
c. The slides should be quite presentable to the public.
d. The presentation should run automatically.
e. Indicate your name arid index number on the header.
f. Save your file as Malaria 2014 on the on Local disc D.
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QUESTION 25
The school has been assigned to make a presentation about its nature of studies
being offered. As a result offering computer studies, you are required to: a) Create a presentation comprising of 3 slides.
b) Slide one should contain the body.
c) Slide three the conclusion.
d) employ good effects that will make the work impressive
e) The slides should have a least three different transactions.
f)

the presentation should run automatically

g) Indicate your name and index number on the header.
h) Create folder on the desktop and name it in your names
i)

Save your presentation as ―Studies Millennium, in your folder on the
desktop.

QUESTION 26
As an education officer, you have been assigned to sensitive projecting your locality
on ―the importance of Education‖
You are required to;
Design three slides as follows:a) Slide I should represent the introduction of the topic.
The introduction should include the following.
(i) Definition of Education
(ii) Relevant information in respect to education. (History of Education in Uganda
preferably your district, Village)
b) Slide II should represent content of education 4 types of education) include a
conclusion.
c) Slide III should represent the benefits and shortcomings of education. Include a
conclusion.
(i) Have minimal graphical effects, in the presentation.
(ii) Include your name and index number at the end of each slide.
(iii) Save your presentation as ―my slide‖
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QUESTION 27
A travel agent has been invited to an international tour and travel exhibition. The
travel agent wants to market Uganda‘s tourism sector using a power point
presentation of 10 slides, with the following.
i. Title Slide with the company name of presenter a variety of slides detailing the
tourism attractions of Uganda.
Prepare a presentation for the agent as described below.
ii. One title slide.
iii. Two slides about eco tourism (forests, botanical gardens, etc.)
iv. Three slides on, physical features mountains, rivers and waterfalls, lakes)
v. Three slides of animals tourism (national parks, game reserves and wildlife
centers)
vi. One slide on hotels, travel transport.
a. Your presentation should include at least three pictures, a uniform
background for all the slides.
b. Slide heading should be font size 38 and body font size 34.
c. Put navigation tools on each slide to the home, text slide, previous slide and
the end slide
d. Save your presentation as Tourism
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ELECTRONIC SPREADSHEETS
(Ms. EXCELL).
Throughout the ages, people have always wanted to calculate. Tools such as the
abacus were invented by the earl Chinese to help keep track of large numbers.
About thirty years ago, students only had pen, paper, slide rules and mathematical
tables to help them in their mathematical examinations. There were no such things
like calculators and certainly, no personal computer.
Calculators eventually became an everyday tool and certainly helped to speedup
calculations and improve on the accuracy. Even then, they weren‘t really good
enough to solve complex problems or deal with large amount of repetitive work.
With advancement in technology, spreadsheets were developed.
An electronic spreadsheet: is application software used to calculate, organize and
analyze numerical data.
Or
It can also define as the intersection of rows and columns.
Or
One can also say that it is a piece of software used to work out calculations.
A spread sheet can do a lot more than simply adding up a column of numbers
spread sheets can handle financial calculations for a large business, calculate
Probability or even other statistical information, do complex trigonometry and make
colorful graphs and charts.
Examples of spreadsheets applications include;
(i) Microsoft Excel,
(ii) Lotus 1-2-3
(iii) Corel Quattro Pro.
(iv) VisiCalc
(v) Ms -DOS
(vi) Open Office.Org Calc
Components of an electronic spreadsheet.
• Worksheet - A rectangular grid made u of rows and columns:
• Database - Enable the •user to perform functions such as sort, filter, subtotaling
and consolidation on worksheet data. A spreadsheet file can also be saved with a
.dbf extension to make it accessible from other applications using a db engine
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• Graphs - Visual representation of data on a chart.
Advantages of Electronic spreadsheets.
• They have large worksheets compared to manual spreadsheets.
• They automatically adjust the result whenever a value is changed in a cell(s) that
is referenced by a formula.
• They have superior editing and formatting features hence producing neat work.
• Easier entry of data due to typing aids such as auto complete, autocorrect, copy
and move
• It is possible to forecast or predict the outcome of changing values in one or more
cells.
• Analytical graphs or charts lets one provide visual representation of data from a
worksheet.
• Easy management of large amount of data using data management features such
as sorting, filtering, data validation and subtotaling.
Applications of Electronic Spreadsheets
• Statistical analysis such as mean, standard deviation, variance etc.
• Accounting such as balance sheet preparation, loan repayment, and mortgage
and investments analysis.
• Forecasting — What if analysis, solver, goal seek and scenario in most
spreadsheets evaluate the effect of changing a value to achieve a certain goal for
managerial purpose.
• Mathematical and scientific solution such as arithmetic, trigonometric, rounding
off and multiplication.
Features of a work sheet (Work book basic features)
Apart from the title bar, Menu bar, Standard toolbar and Status bar: found in Word
processing, Spreadsheets have the following additional features.
1. Formula bar. Is an area where a cell entry or a formula is displayed before being
entered into the selected cell
2. Worksheets. A worksheet is the area made up of rows and columns where data
is entered. In Excel, a spreadsheet file is referred to as a workbook which consists
of one or more related worksheets.
3. Cells. A cell is an intersection between a row and a column. A column is a
vertical arrangement of cells labeled A, B, C while a row is the horizontal
arrangement labeled 1, 2, 3.
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Worksheet tabs. These are located at the bottom of a spreadsheet. They show the
number of worksheets in the workbook. Note that one worksheet may have several
pages.
4. Searching and sorting: this gives the u, ability to search the worksheet for any
phrase, number or even other texts. It even makes the user scroll between the
search results.
5. Import and export: spreadsheets can be transferred onto and off the mobile
phone using a window explorer on the d. Spreadsheets can also be e-mailed as
attachments, from within the spreadsheet application.
A workbook window.

Figure 7
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WORKING WITH WORK SHEETS.
1. Entering Data into a Worksheet.
When entering data item into the work sheet, the entry is displayed in the formula
bar before you move to another cell. To place the content to the selected cell, press
Enter key or an arrow key or click into another cell. Below are the three main cell
entries:
• Labels -alphanumeric characters or text that describes the content of a row or
column e.g. names.
• Values - numeric characters 0-9 and dates that can be manipulated
mathematically.
• Formula and Functions - while a formula refers to a mathematical expression, a
function is
2. Saving a workbook:
To save a workbook:
•

On the office button (File menu), click Save As. Alternatively click the Save
button on the standard toolbar.

•

Select the storage location.

•

Type the name of the workbook then click the Save button

Saving window for a work book.

3. Protecting a workbook
To protect a worksheet or workbook from unauthorized access or modification:
•

On the Tools menu, point to Protection, and then select Sheet or Workbook.

•

Click check boxes for protection options.
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•

Type a password, and then click OK.

4. Editing a Worksheet
Editing a worksheet involves deleting, copying, moving, finding and replacing as
well as spells checking.
Editing cell Entries
There are two methods of editing a cell entry:
•

Using the Formula bar — click the cell to display 1 6ntrf on the formula bar.
Delete or insert required word or text.

•

Double click the cell to place the insertion pointer in the cell and then type
or modify the entry.

5. Deleting worksheet content
To delete worksheet data:
•

Select the cell or range of cells.

•

Press the delete or backspace key. Alternatively select Clear on the Edit
menu.

6. Copying and moving cell contents.
To copy cell(s) content,
•

Select the range of cells.

•

On the Edit menu or standard toolbar select Copy.

•

Click the cell where you want the content to be copied.

•

On the Edit menu click Paste.

7. to move cell s content,
•

Select the range of cells.

•

On the Edit menu or standard toolbar select Cut.

•

Click the cell from where you want the content to be moved.

•

On the Edit menu click Paste.

8. Inserting and deleting rows and columns.
To insert a new column or row.
•

Position the pointer where the new row or column will appear.

•

On the Insert menu, click Rows or Columns.

9. To delete a column or row.
•

Select the column or row to be deleted.
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•

On the Edit menu click Delete.

10. Inserting and de1eting.worksheets
•

On the Insert—menu, click Worksheet A new worksheet is—added into your
workbook.

To delete a worksheet.
•

Click the Worksheet tab.

•

On the Edit menu, click Delete Sheet.

11. Find and Replace.
To search and replace a specified range:
•

On Edit menu, click Find, type the text to search for.

•

To replace, choose Replace from the dialog box.

•

In the Find what box, type the word or phrase to find.

•

Click the Replace tab and in the Replace With type the word or phrase to
replace the found word or phrase.

12. Correcting spelling mistakes
•

Specify the worksheet range you want to spell check.

•

On the Tools menu, click Spelling or press F7.

•

On spelling dialog box replace or ignore the misspelled words

13. Formatting a Worksheet.
•

Formatting makes a worksheet more visually appealing. In most cases we
apply formatting features to numbers, alignment, font, borders and patterns
or shadings.

•

To apply these formats:

•

Select the range to be formatted.

•

On the Format cell menu, click format Cells. The Format cells dialog box is
displayed.

Figure 8
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14. Formatting a Worksheet. Click any of the following tabs:
•

Number to apply number formats such as general, currency, percentage and
custom.

•

Alignment to align and rotate cell entries, merge and centre cells across
columns.

•

Font to apply font type, style, size and color.

•

Border to apply cell borders and outline.

•

Pattern to apply background shading.

•

•. Protection to lock cells and hide formulas. .

•

Click the OK button to apply.

15. Adjusting Column and Row size.
To resize a column width or row height
•

Position the mouse pointer on the border of the column or row header.

•

Drag to increase or to decrease the column width or row height.
Alternatively, select a cell on the row or column you want to change then on
the Format menu, point to Row or Column. Specify the row height or column
width.

16. Freezing panes
Freezing panes makes selected data to remain visible when scrolling in the rest
parts of a wide worksheet. To freeze panes:
•

For the top horizontal pane, select the row below where you want the split to
appear.

•

Press Ctrl key to select a column to the right of the pane.

•

From Window menu, click Freeze Panes.

Figure 9
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17. Hiding rows and columns
If your worksheet is too large to fit in the screen, you may decide to hide some part
and leave only what you want to see at that particular moment.
To hide rows or columns:
•

Highlight the rows or ‗columns to hide.

•

On Format menu, point to Row or Column, then click Hide.

To unhide rows or columns:
•

Highlight a row or column on each side of the hidden rows or columns while
pressing the shift key.

•

On Format menu, point to Row or Column, and then click Unhide.
PERFORMING CALCULATIONS IN A WORKSHEET

1. Using basic formulae.
A formula is a mathematical expression used to solve mathematical problems. A
formula must start with an equal sign (=) while cell addresses are used as operands
instead of values.
a. Arithmetic operators.
•

These mostly follow the rule similar to mathematical concept of BODMAS.
I.e. whatever is in parenthesis is evaluated first. Multiplication and division
are evaluated from left to right while addition and subtraction are evaluated
last.

Summary of operators used to create formulae.
Table 8
Symbol

Description

Example

/

Division

= A2/B2

*

Multiplication

=A2*B2

+

Addition

=A2+B2

-

Subtraction

=B2-A2

b. Relational operators
A relational operator returns either true or false depending on the magnitude of the
value being evaluated. Summary or relational operators
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Table 9.
Symbol

Description

Example

=

Equal to

=A2=B2

>

Greater than

=A2>B2

<

Less than

=A2<B2

<>

No equal to

=B2<>B2

<=

Less than or equal to

=A2<=B2

>=

Greater than or equal to

2. Cell Referencing
There are three types of cell referencing used when creating formulae and
manipulating cell(s), content:
a. Relative referencing. When.‘ you copy a formula that contains cell references,
say A3, the references adjust to their new location. E.g. If C1 containing a formula
=A1+B1 is copied to C2, the reference changes to A2+B2.
b. Absolute referencing. The reference is4ikde to a specific address and does not
change even if the formula is copied to another cell. In Excel an absolute cell
reference is made by placing a dollar sign before the referencing. $A$2, i.e. if the
result in C1 is 170 if absolute reference is used, 170 will be copied to C2.
c. Mixed cell referencing. This is a combination of relative and absolute reference,
e.g. $A3 or A$3. In the first case the column reference is absolute while the row is
relative; in the second case the column reference is relative while the row reference
is absolute.
2. Using in-built functions
A function is a predefined formula used to perform calculations. A function must
also start with an (=) sign followed by the function name and arguments.
Arguments are numeric, logical values or text enclosed in parenthesis. E.g., in
=SUM (A3:F3), SUM is the function that adds the range A3 to F3 which is the
argument.
Functions are categorized according to the nature of problems they work on. These
include:
• Mathematical
• Statistical
• Logical
• Date and time.
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3. To use a function from any category:
•

On the Formula menu, click Function. Alternatively, click the fx button on
the standard toolbar.

•

Select insert

•

In the function dialog box displayed select the category.

•

In the function list box, select a function.

•

Specify the function argument then click OK.

Figure 10

4. Using Mathematical Functions.
•

Commonly used mathematical functions are:

•

SUM () - Adds all the value in the selected range of cells. For example, if A3,
B3 and C3 contains 20, 50, and 80 respectively, =SUM (A3:C3) returns 150.

•

ROUND () Rounds a number to a specified number of decimal places. Zero
rounds off the number to the nearest integer. E.g., =ROUND (49.769,1)
returns 49.8, while
=ROUND (49.69, 0) returns 50 and 70 respectively.

•

SUMIF () — conditionally adds the specified cells according to the set
criteria. =SUMIF (A3:A1O, ―>= 1000‖), returns a value if, and only if, the sum
is greater than or equal to 1000.

•

PRODUCT ()- Multiplies all the values in the argument. Eg, =PRODUCT (40,
3, 2) returns 240.
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5. Using statistical functions.
•

The commonly used statistical functions are:

•

AVERAGE () — Returns the arithmetic mean of its arguments. E.g., if A3, B3
and C3 contains 20, 50 and 80 respectively, =AVERAGE (A3:C3) returns75.

•

COUNT ()- Counts the number of cells that contain numbers within a range.
E.g., =COUNT (A3:C3) returns 3.

•

COUNTIF - Conditionally counts the number of cells within a range that
meets a given condition. E.g., if A3, B3, C3, D3 and E3 contains 20,50,80,60
and 45 respectively then =COUNTIF (A3:E3, ―>50) returns 2.

•

MAX 0 - Returns the largest value in a set of values or within a range. E.g.,
=MAX (A3:E3) for the set values above returns 80.

•

MIN () - Returns the least value in a set of values or within a range. E.g.,
=MIN (A3:E3) returns 20.

6. Using logical Functions
The commonly used statistical functions are:
IF ( ) - Returns a value or label if a condition you specify evaluates to TRUE and
another if it evaluates to FALSE. Eg, if; A3,B3,C3,D3, and E3 contains a set of
marks 35,50,80,60 and 45 and grades are to be awarded as follows:
80 - 100 A
60 - 79 B
40 - 59 C
Below 40 Fail,
To assign a grade, use;
=IF (A3>=80, ―A‖, IF (A3>=60, ―B‖, IF (A3>=40, ―C‖, ―Fail‖)))
•

AND () - Returns true if all its arguments are true or false if any argument is
false. E.g., =AND (3+2=5, 2+2=4) returns true.

•

OR () — Returns true if any of its arguments is true or false if both
arguments are false. E.g., =OR (3+2=7, 2+2=4) returns true.

•

NOT ( ) — Negates the unary operand. E.g., =NOT (.3+2=5) returns false.

THE VLOOKUP FUNCTION.
NB. It‘s important to note that this function is only applicable in Subsidiary ICT (A
‗level) but not at O‘level. This is according to UNEB standards. But it is vital if
students at all levels understood how the function is applied.
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The V in VLOOKUP stands for vertical. Use VLOOKUP instead of HLOOKUP when
your comparison values are located in a column to the left of the data that you
want to find.
THE VLOOKUP SYNTAX
VLOOKUP: this is a function that looks for a value in the left most column ofthe
table and then returns a value in the same row from a column you specify.
By default the table must be sorted in ascending order
Function
VLOOKUP (Look up_value, table_array,col_index_num ,[range_lookup])
Lookup value - The value to search in the first column of the table array. Lookup
value can be a value or a reference. If lookup_value is smaller than the smallest
value-in the first column of table_array, VLOOKUP returns the #N/A error value.
Table_array- Two or more columns of data. Use a reference to a range or a range
name. The values in the first column of table_array are the values searched by
lookup_value. These values can be text, numbers, or logical values. Uppercase and
lowercase texts are equivalent.
Col_index_num- The column number in table_array from which the matching
value must be returned. A col_index_num of 1 returns the value in the first column
in table_array; a col_index_num of 2 returns the value in the second column in
table_array, and so on. If col_index_num is:
i.

Less than 1, VLOOKUP returns the #VALUE! Error value.

ii.

Greater than the number of columns in table_array, VLOOKUP returns the
#REF! Error value.

Range_lookup- A logical value that specifies whether you want VLOOKUP to find
an exact match or an approximate match:
i.

If TRUE or omitted, an exact or approximate match is returned. If an exact
match is not found, the next largest value that is less than lookup_value is
returned.
The values in the first column of table_array must .be placed in ascending
sort order; otherwise, VLOOKUP may not give the correct value. For more
information, see Sort data.

ii.

If FALSE, VLOOKLUP will only find an exact match. In this case, the values
in the first column of table_array do not need to be sorted. If there are two or
more values in the first column of table_array that match the lookup_value,
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the first value found is used. If an exact match is not found, the error value
#N/A is returned.
Remarks
 When searching text values in the first column of table_array, ensure that
the data in the first column of table_array does not have leading spaces,
trailing spaces, inconsistent use of straight (‗ or ‗) and curly (‗ or ―) quotation
marks, or nonprinting characters. In these cases, VLOOKUP may give an
incorrect or unexpected value. For more information
 When searching number or date values, ensure that the data in the first
column of table_array is not stored as text values. In this case, VLOOKUP
may give an incorrect or unexpected value. For more information, see
Convert numbers stored as text to numbers.
 If range_lookup is FALSE and lookup_value is text, then you can use the
wildcard characters, question mark (?) and asterisk (*), in lookup_value. A
question mark matches any single character; an asterisk matches any
sequence of characters. If you want to find an actual question mark or
asterisk, type a tilde (~) preceding the character.
7. Using date and time functions
Some date and time functions include:


TODAY () - Returns a number that represents today‘s date. The function
takes no arguments. E.g., =TODAY () returned 09/01/2008.



NOW () - Returns the current date and time formatted as date and time. It
takes no arguments. E.g., =NOW () returned 19/02/2007 00:02.

•

DATE () — Function Returns a serial number that represents a particular
date. Ms Excel uses year 1900 serial number1. E.g., =DATE (107, 1, 4)
returns January 4, 2007. Year = (1900+ 107), month=l, day =4.

•

HOUR () ,MINUTE() or SECOND ()- Functions returns the current hour as
number 0 to 23, minute from 0 to 59 and seconds from 0 to 59 respectively.
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WORKSHEET DATABASE MANAGEMENT.
Some database operations that can be performed on a worksheet database include
data entry using data forms, sorting, filtering, subtotaling and input validation.
1. Data entry using forms
Data form allows the user to easily display and enter records into a worksheet
database. To display a form:
•

Position the cell pointer in any cell containing data.

•

On the Data menu, click Form. .

(You can navigate the records, add a new record delete or find a record.
2. Data entry using forms.
Data form allows the user to easily display and enter records into a worksheet
database. To display a form:
•

Position the cell pointer in any cell containing data.

•

On the Data menu, click Form.

You can navigate the records, add a new record delete or find a record
3. Sorting
To sort a list:
•

Select the range or click a cell in the list you want to sort.

•

On the Data menu, click Sort.

•

In the Sort by and Then by boxes, select the columns you want to use as the
sort fields.

•

Select sort order either ascending or descending then click OK.

Figure 11

4 Filtering
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To filter is to display records that meet certain criteria.
To filter a list:
•

Select a cell in the list to be filtered.

•

On the Data menu, points to filter then choose Auto Filter or Advanced
Filter.

•

Click the Arrow displayed in the column header.

•

Select a filter criterion.

5. Subtotaling
A subtotal is used to summarize a worksheet list to display grouped subtotals and
a grand total. The list is grouped using preferred field. To create subtotals:
•

Sort the data in ascending or descending order.

•

Click a cell in the list then from Data menu click Subtotals.

•

In At each change in box, select the field to use for grouping.

•

In the Use function box, select a function you want to use.

•

In the Add subtotal to box, check the columns that contain values you want
to subtotal.

Click OK.
6. Input validation
To ensure that a user does not enter invalid data, set the validation criteria.
An error message is displayed when data that violates this rule is entered.
To set data validation:
•

Highlight the range of cells to validate.

•

On the Data menu, click Validation.

•

Click the Settings tab and select a validation criterion

•

To display an input message when the cell is selected, click the Input
Message tab, type the message to be displayed and check ―Show input
message when cell is selected‖.

•

Set the Error alert then click OK.

7. Creating charts and printing
A chart is a component of a spreadsheet program used to present data from a
worksheet in a way that provides instant visual impact. E.g. Column and bar
charts, pie chart, line graph, scatter diagram and area graph. To create a chart:
•

Highlight the range.

•

On the Insert menu, click Charts. Alternatively, click the Chart button on the
standard toolbar.

• The chart wizard will guide you through the process.
Editing and formatting a chart.
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•
•

Click the chart to‘ select it. .
On the Chart menu, click:
 Chart type to change the selected chart to a different type.
 Chart options to set chart properties such ‗as title and legend.

Location to place the chart in a separate sheet or on a worksheet.
8. Printing Workbook Content
You may print an entire workbook, worksheet, chart or a selected range. To print
workbook content:
•

On the File menu, click Print.

•

Specify the print options in the dialog box, and then click OK.

ERRORS ALERTS IN FORMULAE & FUNCTIONS AND HOW THEY CAN BE
CORRECTED
Table 10
Error Message
###########

#DIV/0!

#N/A
#NAME?
#NUL!

#NUM!

#VALUE
#REF!

Description

Solution

The column is not wide enough to
accommodate the value or a negative
date or time is used e.g. =
(2/4/2007)
Division by zero or using a blank or
cell e.g. = 45/0

Increase the column width or
shrink the contents to fit the
column. Avoid using negative
time or date value.
Change the cell reference one
that contains a value nonzero
in the cell.
Make use of a valid argument
or the correct type of value
Correct the spelling of the
name.
To refer to two areas that don‘t
intersect, use a comma (,) e.g.
= (SUM(A1:A10,C1:C10))
Use numeric arguments in a
formula or function e.g. S
Enter 1000 not Ush 1000
Make sure that referenced cells
by the formula contain values.
Change the reference in the
formulae, or restore the deleted
cells.

The formula or function uses a name
that Excel does not recognize
The formula or function uses a name
that Excel does not recognize
The formula references an invalid
intersection of cells
Due to use of invalid numeric values

The formula or function uses
incorrect argument or operator
Due to invalid cell referencing as a
result of deleting referenced cells.
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RESOURCE QUESTIONS FOR EXCEL

QUESTION 1
The information below is driven from MUFTI Limited from some few selected
staff. The staff include JACKIE, KENT, PAULINE, UNICE, XAVIER, LEONALD,
SONNY, CHRISTINE, PHILIPER and INNOCENT. They earn the following amount
as basic salary respectively: 660000, 760000,870000, 580000, 600000,
610000, 630000, 640000, 650000 and 555000.
(i)

Enter the above information using Microsoft Excel.

(ii)
(iii)
(iv)
(v)
(vi)
(vii)
(viii)
(ix)
(x)

A lunch allowance for all employees is 22% of their basic pay.
Housing allowances are 62% of lunch allowances.
All employees are paid transport allowances of 59,000
Compute the employees‘ gross pay.
PAYE is 2.5% of basic salary.
National social security fund is calculated at 18% of gross pay.
Compute the employees‘ net pay.
Plot a line graph of net pay against basic salary in worksheet 2.
Save your work in your name and registration number on the desktop.

QUESTION 2
Study the following multiplication table.

Required:
(i)
Enter it into an Excel worksheet.
(ii)
Enter a formula to B3 that will generate for you the product of A3
and B2.
(iii)
Copy the formula entered to B3 to other blank cells.
(iv)
Apply borders to the table.
(v)
Save the file as Multiplication Table.
(vi)
Rename Sheet1 to Multiplication Work.
(vii)
Put your name as footer.
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QUESTION 3
The table below shows the common sales (in thousands) of liters of liquid milk of
four farms in a certain district during the third quarter of the year 2008.
Wairaka
July
93.2
August
5.1
September 40.2

Butiki

Walukuba

Bugembe

0.4
84.5
7.6

55.6
9.6
98.7

78.1
62.2
44.2

Required
(i). Enter the above information to a spreadsheets application.
(ii). Create a pie chart that includes a title and labels to represent the sales of
the four farms in the third quarter of 2008.
(iii). Draw a bar chart to represent the sales of the farms.
(iv). Determine the total sales for each month.
(v). Insert your name and index number as footer in the documents created in
(ii) and (iii) above.
(vi). Save your work as My Spreadsheet.

QUESTION 4
The following students sat for their term two examinations in Mathematics (mat),
Computer studies (comp) and commerce (com) and obtained the following marks:
John got 40 in mat, 20 in comp and 50 in com. Mary got 90 in mat, 60 in comp, 30
in com. Tania got 75 in mat, 65 in comp, and 90 in com. Samuel got 55 in mat, 40
in comp and 80 in com. Paul got 50 in mat, 20 in comp and 35 in com. Albert got
50 in mat, 60 in comp, and 50 in com.
(i)
(ii)
(iii)
Iv

Enter the data given in spreadsheet. All names should be in column A.
Use a formula to compute the total for each student and put them in column
E.
Sort the data entered in column E in descending order.
How many students got a D1 in Math given that a D1 was awarded at 75%

(v)

Put the titles for column A, B, C, D and E in orientation 450.

(vi)

Give your work a professional look.

(vii)

Plot a bar/column graph for the students‘ marks in the three (3) subjects.

Your graph should have appropriate heading and axis
(viii)
(ix)

Include a header as your name and save your work as ―Senior four Exam‖
Print your work.
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QUESTION 5.
Abili Secondary School received the following products from different suppliers at
the beginning of term II 2017.
Table 10

1
2
3
4
5
6
7
8
9
10
11
12
13

Product

Quantity
(Bag)

Sugar
Posho
Cement
Rice
Millet
Cassava
Irish
Onion
Bean

20
50
70
30
5
15
17
4
60

ABILI SECONDARY SCHOOL
Cost per 50
Total
VAT
kg Bag
Cost
(Sh.)
225,000
85,000
40,000
125000
80,000
50,000
400,000
500,000
150000

Tax =

Net pay

Grade

18%

(i) Use available spreadsheet application to enter the entire records in the table.
(ii) Apply functions or formula to automatically compute:
o

Total Cost of these products.

o

The VAT if its 18% of the total cost.

o

The Net pay per each product supplied.

(iii) In column G, use function to position these products beginning with the
most expensive one as position 1 and end with the less expensive one as
position 11.
(iv) Make your work look professional.
(v) Draw a column graph to compare the net pay for these products. Label the
axes and title clearly.
(vi) Indicate your name as footer.
(vii)

Save your work with file name ―Abili Sec School‖.

QUESTION 6.
Below is an extract of Daily paper sales of one of Red Pepper. Use it to answer
the questions that follow.
RED PEPPER WEEKLY DAILY SALES
Table 21

AGENT
New Taxi Park
Mubende
supermarket

MON

TUE

WED

THUR

FRI

SAT

25000
65040

54000
68040

54000
9600

45000
65000

54010
65000

65000
54600

SUN
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Lugogo mall
Highest sales
Lowest sales

65400

43000

53000

41000

40700

52110

(a) Enter the above data using any spreadsheet application your choice.
(b) Use appropriate functions to determine
(i)
Total sales
(ii)
Highest sales from Monday to Sunday
(iii)
Lowest sales from Monday to Sunday
(c) Determine the sales made on Sunday given that the sales on that day
declined by 30% of those made on Saturday. Be sure to use absolute sale
reference.
(d) Use a function to return a comment ― Good sales‖ and ―Bad sales‖ for sales
exceeding a total of 200000/(e) Format your figures to have a suffix UGX to two decimal place values
(f) Include a column graph showing the above daily sales
(g) Ensure that your Graph is on a separate sheet with all attributes such as
legend, title. Rename the new sheet Graph
(h) Save and print your work.

QUESTION 7.
A school produced an end of term mark list for senior five using any spreadsheet
program; enter the data into the table below.
NAME DIV

HIST

SUBMATH CHEM PHY

ECON

Ali

58

70

63

23

10

89

David

40

6

47

43

54

76

Hama

38

60

59

67

62

54

Mary

60

65

48

73

60

34

Abdul

25

43

67

32

28

21

Julius 70

23

47

41

57

34

Pius

34

37

56

45

42

54

Moss

78

75

34

51

68

32

TL

AVE

POSITION

Table 11
a) Provide a heading for your worksheet as Cadet Secondary school, results for
2012 and centre it with font size 24.5.
b) Using appropriate functions, determine for each student the
i.

Total mark.

ii.

Average mark.

iii.
Position.
c) Apply boarders on the data you have entered in the worksheet.
d) Insert your name and personal number as footer.
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e) The sheet for the table should be name table.
f) Create a pie chart using the average mark and include:
i.

The heading senior five term one mark, Cadet Secondary school.

ii.

Labels with the cart.

g) Copy the chat to sheet 2 and name it chart.
h) Saved your work as your name and personal number.
i) Print your work

QUESTION 8.
The table below shows examination results of senior six students of Mugo
Secondary School. Study it and answer the questions that follow.

4
5
6
7
8
9
10
11
12
13
14
15

OKUMU
NAIGA
APUNU
ODYEK
WAISWA
LUBEGA
KATAIKE
KATEREGGA

DAVID
LILIAN
JOSEPH
TONNY
MAX
KARIM
JENN1FER
JULIUS

80
72
78
78
30
86
59
98

90
85
87
25
56
85
45

80
63
86
86
58
47
64
25

90
47
82
82
58
78
55
93

H

I

GRADE

ICT

PHYSICS

MATH

CHEMIST
RY

3

BIOLOGY

FIRST
NAME

1
2

C
D
E
F
G
B
MUGO Secondary School Six Science Class, 2013
SUBJECTS
LAST
NAME

A

AVERAGE

Table 12

70
90
52
52
67
82
85
69

HIGHEST VALUE
LOWEST VALUE
MEDIAN VALUE

a) Enter the students‘ data above in a spreadsheet application as shown.
b) Using appropriate functions, determine the;
i.
Average score for each student.
ii.
Highest score for each subject.
iii.
Lowest score for each subject.
iv.
Median score for each subject.
c) Make your worksheet landscape page orientation.
d) Name your worksheet as results.
e) Use the relevant function to grade each student‘s average by indicating:


Very good if average is greater than 80.
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• Good if average is greater than 55.
• Poor if average is below 55.
f) Save your work as your name and personal number.
g) Print your work
QUESTION 9.
Pic-Hill Primary School scored the following marks in their Primary Leaving
Examinations.
Table 15

Names
Karungi Hakhim
Muziransa Saad
Semakula Hamissi
Muhumuza Umar
Mbeiza Christine
Isabirye Kalifan
Mpairwe Joshua
i.
ii.
iii.
iv.
v.
vi.
vii.
viii.
ix.

Eng.
90
70
40
60
70
30
70

Maths
80
57
45
40
80
60
6

Science
70
60
60
5.0
78
50
50
V

SST
60
70
50
30
90
45
40

Calculate using spreadsheets the total mark for every student.
Calculate the average mark for every student.
Find the best performer in every subject.
Find the worst performer in every subject.
What is the average mark in every subject?
What is the average total mark?
What is the overall average mark in the school?
Using the VLOOK, find students who scored above 60, gives them PASS and
those below, FAIL.
Make your worksheet look professional.

QUESTION 10.
Enter the following data into a Microsoft excel sheet.
Table 16
Name
Department
Basic Salary
Sophia
Accounting
350000
Beth
Finance
200000
Paula
Accounting
450000
Aisha
Human Resource
365000
Grace
Finance
150000
Sarah
Management
460000
Kate
Transportation
550000
Namubiru
Accounting
650000
Lwanga
Accounting
190000
Hearte
Finance
420000
Trina
Human Resource
800000
Lorena
Management
850000
Morel
Accounting
280000
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Required:
i.

Add a column for employees‘ Age and fill it with figures of your choice.

ii.

Sort the department column alphabetically.

iii.
i.

Extract subtotals for each department‘s basic salary
If employees pay NSSF (National Social Security Fund), PAYE (Pay As You
Earn) and tax which is 2%, 5% and 3% of the basic salary respectively,
introduce a column for NSSF, PAYE and Tax and calculate the net pay after
those deductions.

iv.

Select the names column and Net pay to for a clustered column with 3D
visual effect chart and save it as ―Analysis‖.

v.

Save your work under your names in the folder you created.

vi.

Make a printout of your work.

QUESTION 11.
The school marks are divided into beginning of term (20%) and end of term (80%).
Thus the total mark should be generated with a function that can sum the figures
while considering the percentage weights.
Table 17
Name

Reg. No

E.O.T

U/001

B.O.T
86

Keth
Beth

U/002

67

57

Ham

U/003

78

70

Kit

U/004

95

67

Tim

U/005

42

90

Val

U/006

63

76

Pilly

U/007

59

60

Total Mark

Grade

85

i.

Enter the above data into a worksheet.

ii.

Compute the total mark of the students.

iii.

Insert three rows after Kit and enter Au, Qarim and Natalie‘s marks.

iv.

Using the HLOOKUP, Assign the grade of the students whereby, from 80 and
above assign ―A‖, 6079,‖B‖,40-59‖C‖ and the rest ―D‖.

v.

Change Val‘s end of term marks and put 15.

vi.

Apply an auto format in your work.

vii.

Save your work as your last name and make a printout of your work.
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QUESTION 12.
A Primary Four class teacher of Alokolum P.7 School uses spreadsheet to make
analysis of pupils‘ results. Use it to answer the following questions:
Table 18

Name
Monica
Jane
John
Peter
Nelson
Patria

Math (%)
78
67
55
45
100
82

Science (%)
66
.77
45
56
88
100

SST (%)
67
70
100
82
77
70

English (%)
45
65
84
56
89
87
•...

Lou (%)
89
77
98
100

a) Enter the records in a spreadsheet application and arrange the names of these
pupils in alphabetical order.
b) Use function to auto compute the:
i.
ii.

Total mark of each pupil
Position of each pupil in the class based on total mark scored by each child.

c) Return the total number of pupils who:
i.
ii.

Missed Lou examinations
Scored above 60% in mathematics

d) Use HLOOKUP Function to return the name of the pupil with 100% in
Mathematics
e) Plot a column graph to compare the performance of pupils in Mathematics and
English only. Label all axes, title and legend.
f) Save the work as Alokolum and print the file.
QUESTION 13.
KB Computer Enterprises agreed to maintain an electronic spreadsheet to keep
track of business books for the various branches country wise. The following is a
worksheet used to extract records from business partner‘s vendors.
(a) Enter the following in any available spreadsheet software of your choice and
save as KB enterprises.
Table 19
Branch Name
JCB_Soroti Branch

Cost of
Sales (shs)
700,000

Sales
(shs)
350,000

KB_Lira Branch

400,000

70,000

KB_Hoima Branch
KB_Muni Branch
KB_Wakiso Branch
K_kobOKo Branch

200,000
300,000
650,000
555,000

95,000
175,000
320,000
47,800

Gross
profit(shs)

Expenses
(shs)
45,000
50,000
•
2,500
10,000
55,000
73,000

Reserves
(shs)

Net
profit(shs)

Remarks
(shs)

.
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Additional information
 Reserves is 10% of Gross Profit
 Net profit = Gross profit — (Expenditure + Reserves)
(b) Use appropriate formulae/function to calculate:
i.
ii.
iii.

Gross profit for each member branch
Reserves for each member branch
Net profit for each member branch

(c) With use of a VLOOKUP, use the following criteria to include remarks.




If net profit> = 500,000, then ―V.good Branch‖
If net profit >400,000, then ―Good Branch‖.
If net profit < = 300,000 then ―Dormant Branch‖.

(d) Format your worksheet as follows
i.
ii.
iii.

Include an appropriate title on top of the worksheet well centered and bold
Format the figures in the sale column to 2 decimal places with 000‘s
separators
Column headers should all be aligned to 45°

(e) Use columns for cost of sales and sales to insert a line graph, keep the title of
the graph to be PRODUCTIVE ANALYSIS, format it and place it in a separate sheet.

QUESTION 14
Create a Worksheet and enter the data below.
Table 20
Auto stores

Year 1
1998

Sales Revenue
32600
Cost of Goods Sold
Gross Margin
Variable Expenses
Fixed Expenses
000
Net Profit

Year 2
1999

Year 3
2000

Year 4
2001

48000

62000

96800

6000

6000

6000

.

ATS

Complete the table using the following information.
i.
ii.
iii.
iv.
v.

The cost of goods sold and variable expenses for the Auto Stores are 65%
and 10% of the sales Revenue respectively.
Enter a formula for each quarter to calculate the Gross Margin which is
equal to Sales Revenue minus Cost of goods sold.
Net profit is equal to Gross Margin minus Variable and fixed Expenses.
Add a column called ATS that totals the figures from the four quarters.
Draw a column graph for Net Profit for the four quarters.
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vi.

Add a title ―Auto Stores and label the x-axis as ―Quarterly Net profit‖ and the
y-axis as ―Amount in Shillings‖.

vii.

Save your worksheet as your Name and print.

QUESTION 15
Enter the data bellow into a suitable application program and save it as ―Rawmarks‖
Table 21.
A
B
Student No. Names
01
Harriet
02
Beth
03
Harith
04
Bruno
05
Hyde
06
Hearten
07
Pilly
i.
ii.

iii.
iv.
v.

D
E
Telephone number Test A %
0712445230
53
0702512012
48
O772652310
62
0773652140
85
0782416212
56
0752316242
72
0774512634
62

F
Test B %
43
22
35
68
56
70
62

Copy the work and paste it in worksheet 2 of the same workbook. Name the
worksheet 2 as ―percentage-marks‖.
Given that Test A and Test 13 are marked out of 90 and 70 respectively,
enter appropriate formulae to calculate the percentage marks using
―percentage-marks‖ worksheet.
Use functions to obtain the difference between the highest and the lowest
percentage marks in Test ―A‖ in cell G21.
Calculate the average mark for Test B in cell G21.
Save your work and make a printout.

QUESTION 16.
Create a worksheet and enter the data below:
Table 22
Name
Paul
Kate
Kim
Beth
Harry
Paul
Rita
Sherry
Hearte

SSN
No.
S00I
S002
S003
S004
S005
S006
S007
S008
S009

Working
hours
150
200
300
250
240
200
150
250
280

Rate
of
pay
3000
4200
6000
3500
8000
5000
4000
7500
5800

Advance Overtime Overtime Gross Tax Net
rate
wage
pay
1500
4000
5000
2000
1500
3000
2100
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In this company, month, in case an. each employee works for a minimum of 100
hours in case an employee works beyond the normal hours, the pay rate is
multiplied by 0.5. A tax of 30% is deducted from the gross income of the Employee
and PAYE as 10% respectively. You are required to calculate the following;
a) The overtime pay for the employees.
b) The overtime rate.
c) Gross pay.
d) Net pay.
e) Analyze the employees‘ wage with a siiitab1e chat.
f) Save your work in your folder and also make a printout.

QUESTION 17.
The school did several tests marked out of 20. Use the information given to answer
the questions that follow.
Table 23
Name
Sophia
Beth
Paula
Aisha
Grace
Sarah
Kate
Tin
Val
Pilly

Set 1
59
62
46
85
60
68
72
62
85
10

Set 2
65
50
70
68
49
73
45
60
60
90

Total

Average

Grade

.

a) Calculate the total mark for each student
b) Calculate the average marks for the students
c) Using the ‗If‘ statement, assign grades to students using their averages in a way
that, average above 70, assign a ―Dl‖, 65-70, a ―D2‖, 55-60, a ―C3‖, 50-55, a ―C4‖,
45-49, a ―C5‖, the rest, an ―F‖.
d) Differentiate those who have passed from those who have failed in a way that if a
person has average above 50, then that person has passed, otherwise, failed.
e) Save your work in a folder and also make a printout.
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QUESTION 18.
Enter the following data into a Microsoft Excel sheet.
Table 24

Name
Sophia

Department
Transport

Basic Salary
350000

Beth

Finance

560000

Paula

Accounts

700000

Aisha

Human Resource

450000

Grace

Finance

492000

Sarah

Accounts

646000

Kate

Finance

500000

Harry

Human resource

490000

Kate

Transport

380000

Hearte

Human resource

612000

Trina

Transport

280000

Lorena

Accounts

680000

Morel

Finance

654000

Required:
i.

Add a column for employees‘ age and fill it with the figures of your choice.

ii.

Sort the department column alphabetically.

iii.

Extract subtotals for each department‘s basic salary.

iv.

Copy your work and paste it on sheet 2 to continue with the rest of the
questions.

v.

If employees pay NSSF (National Social Security Fund), PAYE (Pay As You
Earn) and tax which is 2%, 3% and 2% of basic salary respectively,
introduce a column for NSSF, PAYE and Tax and calculate the net pay after
those deductions.

vi.

Select the names column and Net pay to form a clustered column with 3- D
visual effect chart and save it as ―Analysis‖.

vii.

Save your work under your names in the folder you created.
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QUESTION 19.
Using any spreadsheet, type the following information
Table 25
A
CITY
Delhi
Chandigarh
Patna
5aipur
Agra
Total
PERCENT

1
2
3
4
5
6
7
8

B
SALES
15111
26100
17270
19800
29400

C
D
E
EXPENDITURE INCOME/LOSS COMMISSION
13400
24050
15670
21500
25600

F

10

i.

Calculate the income/loss for each of the cities.

ii.

Compute the commission for each of the regions as the percentage of
income, where percentage is as given in cell H2.

iii.

Save the file under the name sales projection.

iv.

Print the worksheet.

QUESTION 20.
A farmer‘s income and expenditure is shown in the spreadsheet below;
Table 26
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

A
RATES

B

C

.

Increase
Decrease

3%
2.5%

INCOME

Maize sales
Wheat sales
Mi1i sales
Total Income

E

‗
37500

EXPENDITURE
Fertilizer
Labor
Transport
Total
Expenditure

16
17
18
19

2000
‗
25000
12500

D

PROFIT

16000
10000
8000
34000
23500

.
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If his expenditure is decreased by 2.5% and income goes up by 3%,
a) Calculate the figures in cells E10 and E16 to find the total income expenditure in
each case.
b) Calculate the figures in cell E 18 to find the profit.
c) Calculate the new expenditure in cells F12, F13 and F14.
d) Calculate the new income in cells F6, F7 and F8.
e) Calculate the new profit in cell 018.
f) Save your work.
g) Print your work.
QUESTION 21
The following students sat for their term one examination in Math (mat),
Computer studies (comp), commerce (corn) and History (hist) and obtained the
following marks.
Abbey got 50 in mat, 30 in comp, 20 in corn and 70 in hist. Obbo got 60 inmat, 56
in comp, 40 in com and 55 in hist. Kato got 8O in mat, 75 in comp, 39 in com and
49 in hist. Val got 49 in mat, 50 in comp, 86 in com and 74 in hist. Ham got 60 in
mat, 45 in comp, 48 in com and 90 in hist. Kim got 62 in mat,53 in comp, 50 in
com and 80 in hist. Tim got 29 in mat, 60 in comp, 49 incom and 78 in hist.
i. Enter the data given in a spreadsheet: All names should be in column A.
ii. Use a formula to complete the total for each student and put them in column
F
iii. Sort the data entered in column F in descending order.
iv. Put the titles for column A, B, C, D; E and Fin orientation 90°.
v. Boarder your work to give it a professional look.
vi. Draw a bar/column graph for the students‘ marks in the four (4) subjects.
vii. Save your work as your name and index number.
viii. Print your name.
QUESTION 22.
The school marks are divided into Beginning of term (30%) and End of term (70%).
Thus the total mark should be generated with a function that can sum the figures
while considering the percentage weights.
Table 27
Name
Keith
Beth
Ham
Kit
Tim
Val
Pilly

Reg. No
U/0O1
U/002 U/003
U/004
U/005
U/006
U/007

B.O.T
86
67
78

E.O.T
85
57
70

95
42
63
59

67
90
76
60

T/MARK

Grade
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A. Enter the above data into a worksheet

a. Compute the total mark for the students
b. Insert three rows after kit and enter Au, Quarim and Natalie‘s marks.
c. Assign the grade for the students whereby, from 80-100 assign A, 6079 ―B‖, 40-39, ―C‖ and 20-39, ―D‖.
d. Change Val‘s end of term marks and put 15.
e. Apply an auto format in your work.
f. Save your work as your last name.

QUESTION 23.
Create a spread sheet of the data above, starting with the item title cell A3 and save
as “stationery 1”
A

1 Item
2
3
4
5
6

Note books
Printing paper
Clip files
Box files
Diaries

7

Counter books

B

C

Opening
stock(O)

Closing Quantities Selling
stock(C) sold(Q)
price (S)

200
400
170
100
95
600

120
160
80
0
30
150

D

E

F

Value of
sales(V)

1500
8000
200
2500
1800
5000
Total value
of sales

i.
ii.

Put the appropriate formula in cell D3 to compute the amount sold.

Copy it to the rest of the column

iii.

Put the appropriate formula in cell F3 to compute v.

iv.

Sum up column F to find the total value of sales.

v.

Use the graph function to draw a bar graph of sales for the various
items .Write your name and index number below the graph.

vi.

Save the graph as My graph
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QUESTION 24
Enter the following data into a Microsoft excel sheet
Table 29
Name
Ali
Bob
Cathy
Din
Eddy
Felly
Gill
Hum
Ethan
Jessie
Kit
Lass
Melisa

Department
Accounting
Finance
Accounting
Human Resource
Finance
Management
Transportation
Accounting
Accounting
Finance
Human Resource
Management
Accounting

Basic Salary
350000
200000
450000
365000
150000
360000
520000
720000
170000
360000
700000
700000
150000

Required
i.
ii.
iii.
iv.

v.
vi.

Add a column for employees Age and fill it with figures of your choice
Sort the department column alphabetically
Extract subtotals for each department‘s basic salary
If employees pay NSSF (National Social Security Fund) and Payee (Pay as
You Earn) which is 3% and 4% of basic salary respectively introduce a
column for NSSF and Payee and calculate the net pay after those
deductions.
Select the names column and Net pay to form a clustered column with 3-D
Visual effect chart.
Save your work as your name.

QUESTION 25
The following members of twegatte saving and cooperative society toOK loans from
gold trust bank. They were charged a handling fee of 5% and an interest
of 15%of theloan.
Name

Loan (Ush)

Period

Kato sulaiman

500,000

2 years

Magembe Ivan

750,000

3 years

Nababi Justine

350,000

2 years

Kapere Douglas

1,250,000

6 months

Sagala Martin

900,000

1.5 years

Tomusange David

2,150,000

5 years

A complete Practical Guide to O ‘level A ‘level and Institutions

Page 95

i.

Create a work sheet with column headings NAMES, AMOUNT, PERIOD,
HANDLING FEES, INTEREST, and TOTAL PAYMENT.

ii.
iii.

Enter the above data.
Using relevant formulae calculate the Handling fees, interest and total
payment for Kato Sulaiman

iv.

Using the copy and paste feature complete calculations for all the members.

v.

Create a 3-D column graph to show the Total payment of each member.

vi.

Save work sheet as <twegatte> in your folder,

QUESTION 26.
Table 30
Enter the following data into a Microsoft excel sheet
Name
Sopiia
Beth
Paula
Aisha
Grace
Sarah
-Kate
Namubiru
Lwanga
Hearte
Trina
Lorena
Morel

Department
Accounting
Finance
Accounting
Human Resource
Finance
Management
Transportation —
Accounting
Accounting
Finance
Human Resource
Management
Accounting

Basic Salary
350000
200000
450000
365000
150000
460000
550000
650000
190000
420000
800000
850000
280000

Required:
i.

Add a column for employees‘ Age and fill it with figures of your choice.

ii.

Sort the department column alphabetically.

iii.

Extract subtotals for each department‘s basic salary

iv.

If employees pay NSSF (National Social Security Fund), PAYE (Pay As You
Earn) and tax which is 2°/9, 5%, and 3% of the basic salary respectively,

v.

Introduce a column for NSSF, PAYE and Tax and calculate the net pay after
those deductions.

vi.

Select the names column and Net pay to for a clustered column with 3D
visual effect chart and save it as ―Analysis‖.

vii.

Save your work under your names in the folder you created.

viii.

Make a printout of your work.
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QUESTION 27.
The school marks are divided into beginning of term (20%) and end of term (80%).
Thus the total mark should be generated with a function that can sum the figures
while considering the percentage weights.
Table 31
Name
Keith
Beth
Ham
Kit
Tim
Val
Pilly
i.
ii.
iii.
iv.
v.
vi.
vii.

Reg. No
U/00l
U/002
U/003
U/004
U/005
U/006
U/007

B.O.T
86
67
78
95
42
63
59

E.O.T
85
57
70
67
90
76
60

Total Mark Grade

.

Enter the above data into a worksheet.
Compute the total mark of the students.
Insert three rows after Kit and enter All, Qarim and Natalie‘s marks.
Assign the grade of the students whereby, from 80 and above assign ―A‖, 6079,‖B‖, 40-59‖C‖ and the rest ―D‖.
Change Val‘s end of term marks and put 15.
Apply an auto format in your work.
Save your work as your last name and make a printout of your work.

QUESTION 28.
Enter the data bellow into a suitable application program and save it as “Rawmarks”
Table 32
A
Student
number
01
02
03
04
05
06
07
i.

B
Names
Harriet
Beth
Harith
Bruno
Hyde
Hearte
Pilly

C
Telephone
number
0712445230
0702512012
0772652310
0773652140
0782416212
0752316242
0774512634

D
Test
A
53
48
62
85
56
72
62

E
%

F
0
Test B %
L
43
22
35
68
56
70
62

Copy the work and paste it in worksheet 2 of the same workbook. Name the
worksheet 2 as “percentage-marks”.

ii.

Given that Test A and Test B are marked out of 90 and 70 respectively, enter
appropriate formulae to calculate the percentage marks using “percentagemarks” worksheet.
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iii.

Use functions to obtain the difference between the highest and the lowest
percentage marks in Test ―A‖ in cell E21

iv.

Calculate the average mark for Test B in cell G2 1.

v.

Save your work and make a printout.

QUESTION 29.
Create the spreadsheet below and save it as Student-marks.
Table 33
STUDENT NAME
HadijahKadondi
LutaleAcram
AhumuzaShamsa
KusiimaNasur
Komugisha Sandra
MaskaHairat
LutakomeBasam
BalukuAiman
NajjingoSohpia

MATHS
67
58
81
45
78
34
56
85
60

ENGLISH
74
65
69
50
76
47
56
88
.55

BIOLOGY
71
56.
70
49
68
65
56.
69
46

Enter the formulae to complete the following:
i.
ii.
iii.
iv.
v.

The
The
The
The
The

marks for each student.
average mark for each subject.
highest mark for each subject.
lowest mark for each subject.
standard deviation per student.

QUESTION 30.
Hill Primary School scored the following marks in their Primary Leaving
Examinations.
Names
KarungiH
MuziransaSaad
SemakulaHam
Hamza Umar
Christine yuda
IsabiryeKa1ifan
MpairweJass
i.
ii.
iii.
iii.

Eng.
90
70
40
60
70
30
70

Math
80
57
45
40
80
60
60

Sci
70
60
60
50
78
50
50

SST
60
70
50
30
90
45
40

Calculate using spreadsheets the total mark for every student.
Calculate the average mark for every student.
Find the best performer in every subject.
Find the worst performer in every subject.
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iv.

What is the average mark in every subject?

v.

What is the average total mark?

vi.

What is the overall average mark in the school?

vii.

Using the IF functions, find students who scored above PASS and those
below, FAIL.

viii.

Make your worksheet look professional.

QUESTION 31.
The following spreadsheet shows the profit or loss on sales at an ice- cream stall
during a four week period.
Table 35
A
1
2
3

B

Ice
cream

4
5
6

C

D
ICE-CREAM STALL

E

F

Expenses
(Ug)
.
900,000
900,000
900,000
900,000

Profit/Loss
(Ug)

Cost price (Ug)
500
800

7
8
9
10

Week
Week
Week
Week

1
2
3
4

Ice-cream
Sales
(Ug)
3000
2500
4500
3000

Orange
juice sales
(Ug)
400
100
100
200

Income
(Ug)
980,000
770,000
1,370,000
940,000

Profit
Loss
Profit
Profit

iii.

State the format of data in cell B6.

iv.

Write down a formula that could be in cell D7 to calculate the income for
week 1

v.

Describe how the formula D7 can be copied into the cells t8, D9

vi.

State the cells that are needed to create a line graph to show the income and
expenses for week 1 and week 4.

iv.

Cell FT contains the function: =IF(D7>E7, Profit, Loss) and is copied into
cells F8, F9 and F10. Write down the function that will be in cell F10.
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QUESTION 32.
Table 38
Employee Age
Nalwanga
Kityo
Abigaga
Akello
Lowery
Bamoshena
Omoding
Nakimuli
OKiru
Olowo
Namutebi

Service

54
34
65
35
60
57
49
29
27
63
27

Salary
120,000
135,000
110,000
150,000
200,000
98,000
78,000
140,000
95,000
130,000
115,000

Allowance Gross Taxable PAYE NSSF
pay
amount
70,000
85,000
100,000
130,000
70,000
15,000
10,000
80,000
65,000
20,000
75,800

Net
pay

a. enter the above data into your worksheet and answer the questions below
b. Assuming each employee started working at the age of 23years, compute the
years spent in service (to fill the service column)
c. Taxable amount is computed after deducting NSSF and 13,300 (threshold)
from the Gross Pay, PAYE is 30% of the Taxable amount; NSSF is 5% of the
Gross pay. Compute the Gross pay, Taxable amount, PAYE, NSSF and Net
pay.
d. Insert the following records after Omoding and compute the relevant entries
e. Delete the record for lowery from the worksheet
QUESTION 33.
A company deals in 6 major stationery items namely; counter books,Note books,
printing paper, clip file, box files and diaries. The table belowRepresents the
opening stock (0), closing stock (C), Quantity sold (Q) selling Price (S) and value of
sales (v) respectively where, Q = 0 - C and V = S x Q.
Table 39
A
1 Item
2
3
4
5
6
7

Note books
Printing paper
Clip files
Box files
Diaries
Counter books

B
Opening
stock
(0)
200
400
170
100
95
600

C

D

E

Closing
stock (C)

Quantities
sold (Q)

Selling price Value of
(S)
sales (V)

120
160
80
0
30
150

F

1500
8000
200
2500
1800
5000
Total value
of sales
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i.

Create a spreadsheet of the above, starting with the item title Cell A3and
save it as ―Stationery 1‖

ii.

Put the appropriate formula in cell D3 to compute the amount sold.

iii.

Copy to the, rest of the column.

iv.

Put the appropriate formula in cell F3 to compute V.

v.
vi.

Sum up column F to find the total value of sales.
Use the graph function to draw a bar graph of sales for the various
Items.

vii.
viii.

Write your name and index number below the graph.
Save the graph as ―My graph‖

QUESTION 34.
Below is a table of staff in an association. In one of their documentation, they
require that the following information be captured to come up with a graph.
Table 40

Reg. No
UGA001
UGA002
UGA003
UGA004
UGA006

Name
Namutebi
Kiwewesi
Lule
Sematimba
Kayiwa

UGA007 Kayanja
UGA008 Muwanguzi
UGA008 Mitala

Age
28
37
44
51
55

Address
Lugala
Kasanga
Kawala
Naru
Bwaise

Department
Housing
Sales
Accounts
Computer
Sales

47
48
54

Lubaga
Entebbe
Kalerwe

Housing
Computer
Accounts

V

Basic Pay
800,000
900,000
600,000
600,000

NetPay

1,000,000
5,000,000
900,000
700,000

You are required to:

i.
ii.

Enter the information above in a spreadsheet program. (5 marks)

Insert a title Staff association which is centered in merged cells above
the table records. (2 marks)

iii.

Insert the record of Sematimba between Kayiwa and Kayanja. (1 mark)
Age: 56; Department: sales; Address: Muyenga; Basic Pay: 500,000;
Reg. No:UGAOO5

iv.
v.
vi.

Include a header containing the current date and time. (2 marks)
Include afooter containing your name and index number. (2marks)
Calculate the Net Pay if an allowance of 130,000 is deducted from the
Basic Salary. (2marks)
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vii.

Delete Sheet 2 and Sheet 3. (1 mark)

viii.

Create a pie- chart as a separate sheet to represent the Net Pay of the
various staff. (3marks)

ix.

Save the work on a diskette as ‗chogm‘ in a folder called CHOGM. (2 marks)

QUESTION 35.
The table below represents prices of commodities in various markets in aparticular
town.
Table 41
B

C

2 Rice
3 Sugar
4
Meat

1,000
1,700

1,100
1,650

1,950
1,710

1,100
1,800

2,500

2,20O

2,700

2,800

5 Salt
6 Oats
7

400
1,200

450
1,100

500
1,150

410
1,210

1

A
COMMODITY

i.

D
E
MARKET MARKET MARKET MARKET
3
4
1
2

F

Enter the data as it is in a spreadsheet program. Use formulas to

calculate the average prices of each commodity and insert your
answer in column F. Save your entries as ―market prices‖
ii.

The prices of all commodities in markets 1 and 3 have been levied a
value added tax (VAT) of 17%. Use a formula to calculate the new
prices after VAT and put them in columns H and I .label them ―market
1 with VAT‖ and ―market 3 with VAT‖ respectively. Save changes.

iii.

Create a column graph representing the, prices of sugar in the given
markets. Save it in the same spreadsheet.

iv.

Put your name as the header and the index number and date as the
footer on all copies of your work.

v.

Print your work.
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QUESTION 36
1. ‗This information was extracted from Kyabateeta high school.
Study it carefully to answer the questions that follow.
Table 42
ITEM

COST
SCHOOL PROFITS EXPENSES
PRICE(UGX)
TAX

Sumbiz
Meat pie
Splash
Daso
Pens
Chapuz
Cassava chips
Boxers
cakes

SELLING
PRICE
7,000/=
25,000/=
60,000/
35,0001=
40,0001=
16,000/=
12,000/=
15,500/=
35,000/=

Other information:
Selling price = cost price + school tax + expenses + profits.
Expenses are = 40% of the selling price
Profits are 30% of the selling price
School tax is 10% of the selling price
Tasks:
As someone who appreciates spread sheets principles and functions:
i.

Enter the above information in a spreadsheet application of your choice

ii.

save it as with your real name.
Determine the amount of tax the school gets from the canteen, profits and
expenses for each item.

iii.

Determine the average and total amount of tax the school collects from the
canteen.

iv.

Change the name of the spread sheet 1 to canteen sales.

v.

Determine the cost price for all items.

(At the beginning of next year the canteen operators have asked the school
management that he is going to increase selling price by 20%. Insert a new column
to work out the new prices for all canteen items next year.)
vi.

Format all figures with UGX currency symbol with one decimal place.
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vii.

On a separate sheet, plot a line chart to represent the items, cost price, and
selling price.

viii.

Apply a centered footer of your name and registration number in your work
sheet.

ix.

Sort the list in descending order according to items.

x.

Change the orientation of the first row of the table to 45 degrees and change
its color to blue

xi.
xii.

Copy and paste your work on sheet two, an rename it ‗canteen‘
Wrap your text in the selling price title cell.
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MICROSOFT OFFICE ACCESS
(DATA BASES).
A database is a collection of arranged data in a way that allows access retrieval,
and use of the data.
A database is an organized collection of data. It is considered to be organized
because the data is stored in categories that are accessible ma logical or practical
manner. Data can be anything that has significance to the organization the system
is serving.
Examples of paper databases
1.
2.
3.
4.

Television guides
Dictionaries
Receipt cards
Telephone books
etc.

5.
6.
7.
8.

Libraries
Schools
Business directories
Electricity

Examples of Computerized data bases.
1.
2.
3.
4.

Data base systems in banks
Phone inquiry systems
Organizations like water
Fight information.

Data base software or database management system (DBMS) allows the user to
create, access and manage a database. Most PC databases consist of a collection of
tables organized in rows and columns.
Common terms used in data base
a. Files:
A file is a large organized data structure that contains related data such as records.
Files are used for storing programs and data in secondary storage. This is
extremely important since the main memory is volatile:
b. A Record:
Every entry of data is referred to as a record. A record is a group of related items
that we can treat as a single group. A record is a row in a table that contains
information about a given person, product, or event. (An individual entry in a table)
c. A Field:
A field is a column of similar information or group of vertically arranged data that
contains similar, information of the same data type. Or it can be a column in the
table that contains specific piece of information within a record.
d. Table structure:
This refers to the number of fields, field name (s), field length and data types in a
database table.
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A field name is assigned to each field to identify the different fields.
e. Field length.
This is the maximum number of characters that can be stored for data in a
particular field.
The data type of a field specifies the type of data that the field can contain.
f. Data Validation:
This is the process of comparing the data entered with a set of predefined rules or
values to check if data is acceptable.
Examples of data types used in Data base:
a. Text type: This contains letters, numbers or special characters.
b. Numeric type: This contains numbers only.
c. Currency type: This contains dollar, pound cents etc.
d. Date and time type: This contains text of any kind or length.
e. OLE object: object linking and embedding. It includes objects, graphics or other
binary data.
f. Lookup wizard: When the value that you need exists in another table
or from a list of statistical values you use a lookup wizard to help you establish a
link to the table or define the combo box that will display the list of values on a
form or report other data type may include;
g. Boolean type
Examples of database soft wares include
i.
ii.
iii.

Micro soft access
Micro soft visual
Borland data base
others.

iv.
v.
vi.

Lotus approach
Corel paradox.
Claris file marker pro among

Examples of corporate based systems include:
i.
ii.
iii.
iv.
v.
vi.

SQL
Sybase
Oracle
Informix
Ingress
Progress
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RESOURCE QUESTIONS OF DATABASE.
(MICROSOFT ACCESS).
QUESTION 1.
G4S is a security organization that owns runs a saving scheme for its members. You
have been asked to use a use a database management system (DBMS) to help the
scheme members maintain records of the association.
Table 44.
First
Name
Kintu

Last
Name

Membership
NO

DOB

Age

Membership
Fee (shs)

Fully
paid

Mark

4321

12/11/1990

200,000

Y

Akullo

Warren

5855

10/1/2015

50,000

N

Akongo

Joshua

514

08/08/2003

12,000

N

Kifampa

Bob

123

12/1/1999

10,000

N

Kaleb

Peter

411

l0/03/2014

70,000

N

Ondigo

Sophie

868

12/12/2010

100,000

Y

Wakiaga

Precious

654

14/1/2013

140,000

Y

Aketch

Lucy

744

11/03/1992

60,0000

N

(a) Create a database file called G4S that has the following fields of data for each
member.
(b) Assign an appropriate primary key and data types for your database
(c) Use a form to enter the records in your database save your form as data
(d) Use a query to compute
i.
ii.
iii.
iv.

Age of members of the association, save query as age
Create another query that would be used to display those whose first name
starts with letter A and aged 18 and above name it Age
18‖
For members born between 1990 and 2013, save it as born e) Generate a report
for age query, save report as Age report

f) Print your report
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QUESTION 2.
The table below shows books in a library.
BOKS IN THE LIBRARY
Code
number
2043
5284
4033

0549

Title
The Great Gatsby
Jane
Austen-A
life
Harry Porter and
the Philosopher‘s
Stone
Northern Lights

Borrower Number

Name of
Author
F.Scott
C.Tomalin

Paper Back (P) or
hard Back (H)

Borrower
Number

Date Due
back

P
H

15234
11356

01 June 08
02 June08

J.K.Rowling H

16582

26 May 08

P.Pullman

12982

28 may 08

P

BOWWOWERS
Of Address of borrower

113

Name
Borrower
Tobias Anendra

16582

Carlos Moyes

658 Uhuru High way,
P.o box 2809
12, Avenue De Lupin,
P.o box 65432

Borrowers‟
Number
0772344567

Phone

0712417398

Computers are now widely used in libraries. Using a database .management
systems program:
(a) Create a table of books and enter the data.
(b) Create another table, of borrowers and enter the data.
(c) Sort the records in part (a) in descending order of code numbers.
(d) using fields: code number, title, name of author, paper back or hard back,
date due back, create a query showing borrowers number that is a above 12506
using table in 2 (a).
(e) Create a query, showing only books with hard back and the names of the
author. The names of the authors should be in ascending order.
(f) Create a relationship between the books‘ and borrowers‘ tables.
(g) Put your name and index in the header and the current date and time in the
footer of both tables.
(h) Create a report using both tables and name the report as ―borrowers‖
(i) Save the database as ―library database‖
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QUESTION 3.
The Database Manager of Kakira Primary School provides you with the following
details. Use it to carefully attempt the following instructions.
FamilyName
Kamusiime
Moreri
Mugerwa
Akena
Kakaire
Ssentongo
Babibye
Namulondo
Kafuko
Kimgugwe
Namboso
Aketch
Naigamba
Opio
Akeko

FirstName
Edwin
Nicholas
Ronald
Kennedy
Musa
David
Lonah
Mary
Ivan
Joseph
Hellen
Harriet
Pauline
William
Judith

Sex
M
M
M
M
M
M
F
F
M
M
F
F
F
M
F

Age
17
17
16
18
14
18
19
16
15
13
17
16
18
16
15

Science
50
63
55
22
36
99
55
66
47
12
36
88
71
29
26

SST
77
56
28
47
75
96
35
84
82
82
83
96
72
56
46

English
47
13
83
55
68
91
38
61
53
24
35
56
77
88
68

Maths
88
56
35
78
98
65
65
67
35
81
80
50
60
75
37

Required
(i)
You are required to design a suitable database to manage the above
information, name the Database KAKIRA PS DATABASE.
(ii)
Create a table using Design View, and name it STUDENTS
RESULTS.
(iii)
Create a form called Results Entry Form and enter the above
records.
(iv)
Create a query displaying all the fields in the above table to filter out
only pupils who are females. Save it as Females. Print the query and
its output.
(v)
Create another query displaying all the fields of pupils with ages 15
and above. Name it Aged 15 Plus. Print the query and its output.
(vi)
Create a query displaying all the fields in the above table to filter out
only pupils whose Math marks are between 35 and 81. Name it Marks
between 35 and 81.
(vii)
Create a query to filter out the pupils who scored at least 70 marks in
SST and English. Name it AT LEAST 70 MARKS IN SST AND
ENGLISH. Print the query and its output.
(viii) Create a report showing FamilyName, FirstName, Sex and Age. Name
it Simple Report. Print the report.
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QUESTION 4.
Carefully study the information given below.
StudentID
BCM652
BCM441
BCM102
BCM333
BCM459
BCM245
BCM134
BCM101
BCM376

Surname
Kamusiime
Moreri
Mugerwa
Akena
Kakaire
Ssentongo
Babibye
Namulondo
Kafuko

FirstName
Edwin
Juliana
Ronald
Kennedy
Musa
David
Lonah
Mary
Ivan

Sex
M
F
M
M
M
M
F
F
M

Club
Interact
Debating
Writers
Interact
Writers
Debating
Writers
Interact
Debating

Donation
5000
6300
5500
2200
3600
9900
5500
6600
4700

Required
a) Design a suitable database to manage the above information, name the
Database BCM DATABASE.
b) Create a table using Design View, and name it STUDENTS TABLE.
c) Create a form called Students Entry Form and enter the above records.
d) Create a query displaying all the fields in the above table to filter out only
students who are females. Save it as Females. Print the query and its output.
(a) Create another query displaying all the fields of students with donations 5000
and above. Name it 5000 Plus. Print the query and its output.
(b) Create a query displaying all the fields in the above table to filter out only
students whose donations are between 2200 and 9900. Name it Donations
between 2200 and 9900.
(c) Create a query to filter out the students who donated at least 5000 in Interact
and Writers clubs. Name it Interact and Writers. Print the query and its output.
(d) Create a report using Donations between 2200 and 9900 query. Name it
Report Between. Print the report.
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QUESTION 5.
(a) Using any database software of your choice create this database for Kiti Primary
School
Save it as KITI database. (01 mark)
INDEX
No
KITI/00
1

NAME

GENDE
R
M

MTC

ENG

SST

SCI

Ouma Derick

STREA
M
P7N

43

56

90

15

Peter Biwott
Kirungi. Paul
John Makokha
Kimani Joseph
Mpagi Nofhan
NakanwagiMilly

P7E
P7 N
P7E
P7N
P7E
P7N

F
M
M
F
M
F

52
66
80
89
71
23

65
14
96
63
60
42

77
88
78
43
49
21

61
52
60
25
65
74

(b). Assign a primary Key to one of the most appropriate field.
(c) The student index number should increment by 001
(c). Assign appropriate data types
(d). use lookup wizard for Gender field
(e). Create a form in a tabular form called Students and use it to populate your
database.
(f). Create a query and calculate the total marks obtained by each student which is
the sum ofall the four subjects.
(h). Create a query to display the following
i.
Pupils whose names have character ―gi‖. Save as ―gi‖ query.
ii.
Pupils who scored above 50 in moth, English and are males.
Save as
―Scores‖
iii.
Sort the names in the table descending order
(i). Generate a report to display the information queried in h (ii). Save your report as
Scores final report.
(j). Include logo for the report, header and footer your name and personal number
respectively.
(k). Print out only your data base object ….. Report generated in part (j) above
QUESTION 6.
(a)
Create a table using design view with the following fields: NAME, DATE OF
BIRTH, SEX, RELIGION and FEES BALANCE. Set the NAME field as the primary key
and save the table as ―Candidates Table‖
(06marks)
(b) Creates a form to enter the records below and save the form as ―Candidates
form‖
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NAME

DATE OF BIRTH

Tina T
Golfer J.
Bob Baller
Alice Cricketer
Sam Big
Jenifer J
Musa B

Jan, 02, 90
Feb, 20, 89
Mar, 13, 88
Apr, 04, 89
Jun, 03, 90
Feb, 04, 87
Jul, 05,98

SE
X
F
M
M
F
M
F
M

RELIGION

FEES BALANCE

catholic
Muslim
Protestant
Pentecostal
Catholic
Adventist
Muslim

40,
60,
55,
20,
25,
90,
40,

FEES
BALANCE

000
000
000
000
000
000
000

(c)
Create a query displaying all the students whose names begin with letters ‗B‘
and ‗T‘. Save it as ―BT” query.
(d)
Create another form in ―Design View‖ with all the available records in the given
table and name it ―Design view form‖
(e)
Use a query to calculate the fees balance of the students supposing the school
fees payable is ‟90,000‟. Save the query as fees Balance.
(f)
Generate a report for the above table with FEES BALANCE in descending order.
Use columnar lay out and Portrait as the form orientation. Name this report
―Columnar report 1‖
(g) Generate a query to filter out students who are NOT Protestants and Catholics
(h)
Save your database as your name and index number.

QUESTION 7.
The table exhibited shows the records of hours worked in the month of June 2017
by each employee in one of the wheat industry in Kampala.
EmployeeNo Name

Gender

1
2
3
4
5
6
7
8
9
10

M
F
F
F
M
M
F
F
M
M

Pius Mukasa
Rita Nanono
Susan Akot
Margaret Nin
Paul Toto
Peter Zziwa
Lilian Achan
Joyce Mum
Tom Wawa
James
Semakula

Date
Birth

of Hours
Hourly Total
worked Rate
June
Wedge
2/12/1980
40
25000
14/04/1979 36
30000
30/5/1985
24
38000
5/5/1978
30
26000
7/6/1977
35
22000
6/1/1979
33
20000
4/6/1978
25
25000
25/3/1986
50
15000
23/2/1984
46
22000
24/4/1981
45
24000

A complete Practical Guide to O ‘level A ‘level and Institutions

Page 112

a. Create database file name wheat using any available database management
system application.
b. Design a table called employee with all the appropriate fields and the
primary key.
c. Apply correct data types foe each field.
d. Design a form for the Employee table and name it employee Form.
e. Use the form to enter all the records in the employee‘s table to the database.
f. Design queries that can:
i. Automatically compute the total June‘s wedge per employee and save it
Salary.
ii. Filter Female employees that have worked for more than 40 hours and
save it femal40.
g. Generate a report of Female40 query and name it Female40 report.
h. Save changes and print the report Female40.
QUESTION 8.
The table below shows departmental records of a certain secondary school.
ITEM Table
Table 43
ItemNo
ItemName

Quantity

Arrival Date

Price Per Item

Department

I
2
3

PC
Chair
Microscope

40
100
05

15/2/2015
10/1/2015
5/1/2015

Shs. 1,500,000
Shs. 100,000
Shs. 2,000,000

1CT
Academic
Chemistry

5
4
5
6
7
8

Bible
Voltmeter
Bible
Atlas
Rabbit
Pure 2
Math book
Printers
Smart Board

100
60
100
200
150
300

4/2/2015
20/1/2015
4/2/20 15
30/3/2015
20/3/2015
4/4/2015

Shs. 50,000
Shs.80,000
Shs.50,000
Shs.50,000
Shs.26,000
Shs.75,000

C.R.E
Physics
C.R.E
Geography
Biology
Mathematics

10
11

10/3/2012
13/5/2012

Shs.1,500,000
ICT
Shs.10,000,000 Academic

9
10

Total
Price

a) Create a database called details.
b) Design a table with appropriate primary key, data types in design view called
Items.
c) Create a form called Item. Use the form created in (c) to enter the given
records above.
d) Compute the total Price of all item from the query and save it as price
e) Create a query to display all details of items whose arrival date is not in the
year 2015 save it as Not20l5.
f) Create a query to display all details of items for either Mathematics or
Biology departments. Save it as biomathematics
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g) Create a report to display the information in biomathematics query showing
all details and save as biomathematics
h) Print the report called bio mathematics

QUESTION 9
Create a table with the information below and name it ―patient tab1e‖ (Use
appropriate data type).
Table 45
Reg. no.

First name

Gender

Age

Ailment

Prescription

Review

08/U/12201
06/U/15421
02/U/62452
02/U/45781
08/U/14202
07/U/34752
04/U/21123
08/U/17650
02/U/12431
05/U/18214
03/U/1902
06/U/14352

Ham
Beth
Kit
Harry
Alpha
Chris
Maggie
Morene
Francesca
Keith
Alvin
Grace

Male
Male
Female
Male
Male
Male
Female
Male
Female
Male
Male
Female

20
50
35
42
36
18
62
20
41.
36
42
12

Malaria
Tb
Cancer
Hypertension
Malaria
Headache
Cancer
Headache
Malaria
Hypertension
TB
Malaria

Tablets
Injection
Tablets
Tablets
Drip
Tablets
Tablets
Tablets
Drip
Tablets
Injection
Tablets

3days
1week
5days
2weeks
3days
2days
Month
2days
5days
2weeks
30days
3days

i.

Display the entire data in a form and call it “Patients‟ form”.

ii.

Create a query to reflect all male patients below 2 1 years of age with
malaria ailment and name it ―Malaria patients‖.

iii.

iii Retrieve a report to reflect all patients with hypertension to bereviewed
in 2 weeks. Name it “Hypertension”.

iv.

Create a query to reflect male patients bellow 21 years of age with
malaria ailment and name it “malaria form”

v.

Create a report to view all records sorted with their first names and name
it “all records”.

vi.

vi.. Create a report to view all male patients. Name it “males”

vii.

Create a report for patients on drip.name it “drip patients”

viii.

Save the work and make a printout.
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QUESTION 10.
Recent survey showed the following data. Enter the information below into the table
called ―survey‖
Table 46.
Reg no.

Surname

0006
0010
0007
0127
0053
0008
0021
0458
0500
0080

OKello
Opio
Masaba
Mukasa
Lwanga
Abaho
Mugisha
Akot
Namubiru
Birungi

i.

Firstname
Rose
John
Patrick
Alex
Lydia
Kate
Joseph
Aisha
Grace
Sarah

Sex

Age

Female
Male
Male
Male
Female
Female
Male
Female
Female
Female

15
62
40
20
34
52
5
22
45
31

District
Tororo
Tororo
Mbale
Masaka
Masaka
Female
Kabala
Lira
Kisoro
Masaka

You are required to design a. suitable database to manage the above
information, name the database ―workers‘ database‖

ii.

Create a table using design view, name it ―worker table‖

iii.

Create a form called workers‘ entry form and enter the above records.

iv.

Create a query to show workers from Masaka.

v.

Create a query to show all females above 25 years

vi.
vii.

Create a report for all the names and districts.
Save your work in your folder and make a printout.

QUESTION 11.
Create a table with the information below and name it ―customer table‖. (Use
appropriate data type)
Table 47
Id No.

Name

Gender

U12201
U15421
U62452
U45781
U14202
U34752
U21123
U17650
U12431
U18214

Ham
Beth
Kit
Harry
Alpha
Chris
Maggie
Morene
Francesca
Keith

Male
Male
Female
Male
Male
Male
Female
Male
Female
Male

U19402

Alvin

U 14352

Grace

Title
W.seller
Retailer
W.seller
Retailer
Agent
W.seller
W.seller
Retailer
Retailer
Agent

Sales
revenue
12,000
8,500
10,200
6,000
15,000
62,000
74,000
5,600
8,300
20,300

Cost of goods sold
9,500
6,100
8,200
4,200
7,200
400,000
51,000
2900
1500
10,000

Male

w.seller

16,000

12,100

Female

Agent

4,500

1,300
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i.

Calculate the gross margin for the sales in a form.

ii.

Display the entire data in a form and call it “Patients‟ form”

iii.

Create a query to retrieve all w. sellers and name it “W.seller”

iv.

Create a report to retrieve all male customers Name it “Males”

v.

Create a query to show male agents. Name it “Male agents”

vi.

Sort the names of the customers in alphabetical order.

vii.

Create a report to show all the records.name it “ALL records”

viii.

Make a print out of your work.

QUESTION 12.
Create a table with the information below and name it ―workers‘ table‖. (Use
appropriate data type)
ID.NO

SUR
SEX
TITLE
NAME
ZL001 JESSICA F
CHIEF
WORKER
ZL040 JULIANA F
WORKER
ZL071 ZAK
M
WORKER
ZL160 ANN
F
SECRETARY
ZL178 JAMES
M
WORKER
ZL180 JONAH
M
DIRECTOR
ZL185 EMILY
F
CASHIER
ZL220 JACOB
M
DRIVER
ZL230 JULIET
F
SECRETARY
ZL340 AMIN
M
LIBRARIAN

DEPARTMENT

SALARY

D.O B

MANAGEMENT

730,000

18/06/37

KITCHEN
KITCHEN
RESEARCH
KITCHEN
MANAGEMENT
MANAGEMENT
MANAGEMENT
ICT
RESEARCH

630,000
700,000
385,000
600,000
120,000
700,000
375,000
385,000
420,000

05/08/78
05/06/72
19/06/37
14/05/64
18/08/67
14/05/69
17/06/64
19/08/71
08/12/75

The table above gives information on some workers of an events Management
Company called: ―AMIGO CHEFS CATERING SERVICES”
i.

You are required to design a suitable database to manage the above
information, name the database “workers‟ database”

ii.

Create a table using design view, name it workers‘ table

iii.

Create a form called chefs‘ entry form and enter the above records.

iv.

Create a query displaying all the fields in the above table to filter out only
workers from the department of research. Save it as research department

v.

Create another query displaying all the fields of workers with salary less
than 320,000.name it less than 320,000.

vi.

The amigo chefs‘ catering services promotions age is 52jears. Create a
query filtering out the employees whose ages are above 52.name
itpromotional age.

vii.

Save your work and make a print out.
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QUESTION 13.
The table below shows books in the library.
Data base of books in the library.
Table 49
Id.
Number
5032

Title

Cover

The great Gatsby

Name of
author
F. Scott

P

Borrower‟s
Date due
number
back.
1625
02/05/08

4215

Jane Austen – a life

C. T omalin

H

4212

04/06/08

3042

Harry potter and the

J. K Rowling

P

3215

08/07/08

P. Pullman

h

4215

09/06/08

philosopher‘s stone
5632

Northern lights

Database of borrowers:
Table 50
NUMBER NAME

ADDRES

PHONE NUMBER

1524

Tobias Kalema

P.OBOX 123

0752621342

2635

Carlos Morene

P.O B0X321 0702853215

Computers are now widely used in libraries. Using a database management
systems program.
a) Create a table of books and enter the data.
b) Create another table of borrowers and enter the data.
c) Sort the records in part (a) in descending order of id number.
d) Using fields: id number, title, name of author, cover, date due back, create a
query showing borrowers number that is above 2053 using table 2 (a).
e) Create a query, showing only books with cover and names of the author. The
names of the authors should be in ascending order.
f)

Create a relationship between the books and borrowers‘ tables.

g) Put your name in the header and put the current date and time in the footer
of the report.
h) Create a report using both tables, put your name in the header and put the
current date and time in the footer of the report.name the report as
―borrowers‖
i)

Save the database as ―library database‖

j)

Make a print out of your work.
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QUESTION 14.
The database manager of Kakira primary school provides you with the following
details. Use it carefully attempt the following instructions.
Table 51
FAMILY

FIRST

NAME

NAME

Kamusiime

Edwin

M

17

50

77

47

88

Moren

Nicholas

M

17

63

56

13

56

Mugerwa

Ronald

M

16

55

28

83

35

Akena

Kennedy

M

18

22

47

55

78

Kakair

Musa

M

14

36

75

68

98

Ssentongo

David

M

18

99

96

91

65

Babirye

Lonah

F

19

55

35

38

65

Narnulondo

Mary

F

16

66

84

61

67

Kafuko

Ivan

M

15

47

82

53

35

Kingugwe

Joseph

M

13

12

82

24

81

Namboso

Helen

F

17

36

83

35

80

Aketch

Harriet

F

16

88

96

56

50

Naigamba

Pauline

F

18

71

72

77

60

Opio

William

M

16‘

29

56

88

75

SEX AGE SCIENCE SST ENGLISH MATHS

Required:
i.

You are required to design a suitable database to manage the above
information, name the database ―KAKIRA PS DATABASE.‖

ii.

Create a table using design view, and name it ―STUDENTS RESULTS‖

iii.

Create a form called results entry form and enter the above records.

iv.

Create a query displaying all the fields in the above table to filter out only
pupils who are females.

v.
vi.
vii.
viii.

Save it as ―females‖ Print the query.
Create another query displaying all the fields of pupils with age 15 and
above.
Name it above 15. Print the query and its output.
Create a query displaying all the fields in the above table to filter out only
pupils whose math marks are between 35 and 81. Name it math marks
between 35 and 81.
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ix.

Create a query to filter out the pupils who scored at least 70 marks in SST
and English. Name it ATLEAST 70 MARKS IN SST AND ENGLISH. Print the
query and its output.

x.

Create a report showing family Name, First Name, Sex, and Age. Name it
―SIMPLE REPORT‖

xi.

Print the report.

QUESTION 15.
The table below is a record of employees in a school canteen.
SIRNAME

FIRST

SEX

NAME

DATE OF

TELEPHONE

BOX

BIRTH

NUMBERS

NUMBERS

Mandela

Margaret F

02/16/1967

079-488-888

P.OBOX267 K‘LA

OKello

Joel

M

12/17/1970

090-500-555

P.O BOX433 M‘KA

Nyaika

Ronnie

M

07/28/1980

040-400-767

P.O BOX444 K‘LA

Waibale

Anthony

M

10/03/1979

090-333-212

P.O BOXJJA

Jamila

Liza

F

02/25/1985

099-233-345

P.OBOX 453 K‘LA

Saidi

Juma

M

11/12/1977

011-333-466

P.O BOX123 K‘LA

Zaweede

Zubeda

F

14/12/1977

088-444-666

P.O BOX990 ARUA

a) Create a database named as “Canteen”
b) Create a table of the data above and save it as “Staff record”
c) Choose an appropriate field and make it the primary key
d) Design a form using the database table, and name it “Entry data form” use it
to populate the table. The form should display.
i.

All field options as they appear in the table except the sex field which
should be a combo box to display‖ sex‖.

ii.

Fill the form background with a yellow color

e) Sort the records in the table in descending order of the surnames.
vi.
f)

Filter only female staff employees and produce a report.
Print the report in ascending of surnames.
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QUESTION 16.
Birigwajo establishments Uganda limited has contracted you as their senior
database manager.
a. Using a suitable database software program create a database name it your
name and index number.
Table 53
EMP NO

NAME

SEX

DEPARTMENT

D.O.B

SALARY

P00l

MUSUBIKAE

F

HUMANRESOURCE

2/23/1975

800,000/=

P002

BAALIM

M

ACCOUNTS

3/17/1979

600,000/=

P003

MULUMBAR

M

COMPUTER

12/30/1987

550,000/=

P004

KAFEEROJ

M

ACCOUNTS

5/18/1973

450,000/=

P005

MUKEERA S

F

COMPUTER

11/24/1995

650,000/=

P006

NALUBWAMA A

F

HUMANRESOURCE

8/17/1990

650,000/=

P007

NAMUWONA S

F

COMPUTER

3/22/1989

700,000/=

b. Design a table named Employee table with appropriatedata types in design
view.
c. Enter the given data in the table.
d. Create a query with all fields to filter female employees in the computer
department and save it as ―computer‖
e. Create a query with all fields to filter female employees who are, twenty years
and above use
QUESTION 17.
Use the information in the table below to design a database. Name the table as
tblEmp and store the database file as company.
Table 54
NAME

DATE OF
BIRTH
Akram
20-07-71
Bikala
30-05-78
Njalira
30-06-79
Sentuya
14-04-77
Kebirungi 14-04-77
Katende
12-06-47
Muswabur 25-04-80
Halima
01-01-79

SEX

ID-NO

DEPT

SALARY-PAID
(USH.)
Male
1377841 Accounts 30OO0O
Male
1235542 Sales
400,000
Male
1244745 Accounts 560,000
Male
2213540 Marketing 450,000
Female 1124681 Sales
300,000
Male
1455367 Accounts 350,000
Male
0147535 Sales
700,000
Female 5664124 Sales
350,000

a) Create a form and add more records using the form.
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b) Create three reports to print the information below:
 Employees listed by department type.
 Alphabetical listing of all employees.
 All employees in the sales department get a 2% commission on sales.
c) Create a report to show the commission paid to all the sales people, if the basic
salary for sales people is 300,000.
d) Create a query to show who will be retiring at the end of the year, if the
retirement age is 55.

QUESTION 18.
Tertiary institutions loan board is a government body created to give loans and
bursaries to needy students at the public universities. It is required that the
information of the students is stored in a database for future repayment of the
loans. The following data is stored.
 Name
 Students‘ registration number
 Sex
 Date of entry to the university
 Loan given
 Interest charged
 Repayment period
i.

Create a table to store the above data.

ii.

Create a form to enter data.

Enter 10 sample records. The form should have validation routines to ensure that
the amount borrowed does not exceed Ush.420, 000 and the minimum age of the
student is not below 16.
iii.

Create query called ―loan over 200k‖ that will filter the students who have
been given a loan of more than Ush.200, 000.

iv.

Create a report called repayment to show Name, loan amount, interest
charged, repayment amount and monthly installment.

v.

Create a report that shows a history of loan given out over a period of 10
years. Include a summary showing the total, minimum, maximum and
average loan amount for that period.
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QUESTION 19.
A school in Kiboko County, Mbemba district has a population of 500 students and
various subject Departrnent some twenty students, 12 of the girls live in Mbogo
and Kyadondo houses. The other 8 are boys who live in Kakungulu and Mivule
houses.
Required:
i.

Create a database a database file with the fields:

ii.

Surname, last Name, Age, sex, Registration Number, Address, Class and
Houses for the 20 students.

iii.

Sort the data in (i) above using, surname as the key field. Save yourdatabase
file in a folder under your names on desktop.

iv.

Design a table using the data in (i) above in datasheet view.

v.

Create a query for house members of Mbogo and Mivule houses.

vi.

Create a report showing the fields: surname, class, and house.

vii.

Save your table in your folder as D table.

QUESTION 20.
The following are the members who reside in the UK.
MEMID NAME
STREET
L00l
Muhumuza FaxStreet
L002
Kasaawa
CaxStreet

CITY
London
Bristol

L003

Ssemakula

MarxStreet

L004
L005
L006
L007

Luyima
Cissy
Ahumuza
Tendo

Ex DeWax
FetxWest
MithsDeNt
Bax RxWax

L008

Mbatudde

Mard DeSt

POSTCODE BALANCE CRED- LIM
Wi
10,000
20,000
Bs8 9ee
20,000
15,000
32,000
Lee
Ls3 Ijj
15,000
.
Liverpool
Md6 Ym
20,000
24,000
Birmingham Tr&7
30,000
28,000
London
Yt&6
60,000
76,000
Liverpool
R1
67,000
79,000
Mwx7
Lee
20,000
50,000

L009
L010

Nampeera
Rayaa‘n

CaxTh
Man Tx

Wilshire
Manchester

Mmr
Dd& R

67,000
20,000

79,000
50,000

Required:
i.

Create a table and enter the information as shown above.

ii.

Name your table as members of UK.

iii.

Create a form that can be used to enter data from above table.

iv.

Create a query to display all records that end with ST from the street
field and call it “ST street”
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v.

Create a query that will display all records that begin with M from the
street and call it “Ms tree”

vi.

Create a query that will display all records that are having the word de
anywhere in the field from the street and call it destreet.

vii.

Create a query that will display all customers with the balance between

viii.

25,000 - 50,000.

ix.

Save your work in the folder created on desktop as membership UK

QUESTION 21.
Create a new database and save it as workshop register.
i.

Create a new table for the following fields: Reg No, Names, Sex, Date of
birth, Status, Address.

ii.

Set RegNo as the primary key.

iii.

Save the table as ―attendance registry‖ and close it.

iv.

Modify the table design for the following field properties.

 Reg-no text (size 12)
 Name Text (size 20)
 Date text (format long-date)
v.

Create a form and save it as ―data entry form‖ and use the form to enter the
records here below in the table.

Table 56
REG-No

NAMES

SEX

DOB

STATUS

ADDRESS

Comp/99/045

KatendeMusa

M

12/08/1960

Resident

Mbarara

Comp/99/046

Kebirungi Lailah

F

12/07/1960

Non-resident

Lira

Comp/99/047

Kaliisa Hassan

M

14/11/1965

Resident

Soroti

Comp/99/048

SeguyaAbubaker

M

12/12/1967

Resident

Mbale

Comp/99/049

MatovuUmar

M

17/11/1965

Resident

Iganga

Comp/99/050

WatsembaIsha

F

18/01/1972

Non-resident

Kampala

Comp/99/051

NaggayiShamilah

F

19/11/1960

Non-resident

Masaka

Comp/99/052

Higenyi Ismail

M

20/03/1960

Non-resident

Bushenyi

Comp/99/053

Njalira Moses

M

21/04/1960

Resident

Kampala

Comp/99/054

NaluzzeSharifa

F

22/04/1969

Resident

Kampala

Comp/99/055

BikalaHashim

M

23/11/1970

Non-resident

Mbarara

Comp/99/056

SentuyaFaisal

M

24/02/1960

Resident.

Masaka

Comp/99/057

KasoziSadiq

M

25/05/1955

Non-resident

Soroti
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Comp/99/058

NamenyaNulu

F

26/08/1974

Resident

Bushenyi

Comp/99/059

Kimuli Hood

M

26/08/1974

Resident

Entebbe

Comp/99/060

KaweesaHussein

M

27/09/1957

Resident

Kampala

vi.

Create a form and save it as data entry form and use the form to enter the
records here below in the table.

vii.

Create query displaying only Reg-no, name and sex to filter female
attendants. Save it as female attendants.

viii.

Create a query displaying on Reg-no, name and status to filter out resident
attendants. Save it as residents.

ix.

Create a query displaying attendants whose dates of birth are between
01/01/ 1965 and 01/01/1970.

x.

Create a report out of the above data (ix).name it attendants born between
1965 and 1970.

xi.

Create a report grouping the records by status using the registry table. Give
it a title “COMP99 WORKSHOP REGISTRY”

xii.

Save the report as registry list by sex.

QUESTION 22.
Create a new table using the corresponding raw data below
OLD STUDENTS ASSOCIATION MEMBERSHIP
Table 57

Membership
Shs
2002/001
Shs
2002/002
Shs
2002/003
Shs
2002/004
Shs
2002/005
Shs
2004/006
Shs
2004/007
Shs
2004/008
Shs
2004/009

First
name

Last
name

Se
x

Reg. date

Status

Home
town

Member
ship

Nancy

okumu

F

30/9/2002

ORDINARY

Tororo

50000

Maggie

Kigozi

F

01/01/2003

ORDINARY

Sembabule

Betty

Nassuna

F

02/09/199

EXECUTIVE

Najja

10000
.
80000

Godfrey

Kato

M

04/08/2000

SENIOR

Shinyanga

20000

Mukhata

Wafula

M

09/07/1999

SENIOR

Busia

150000

Diaz

Ogutu

M

28/02/1996

ORDINARY

Nimule

120000

Dianna

Zawadi

F

26/02/1986

EXECUTIVE

Dar

Yoweri

Kaguta

M

25/2/2000

EXECUTIVE

Rwakitura

100000
.
150000

Moser

Helmont

M

20/01/2000

EXECUTIVE

Vienna

250000
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i.

Set membership ID as primary key.

ii.

Create a form based on all the fields in the table, name it membership entry
form.

iii.

Create a form based on all the fields in the table, name it membership entry
form.

iv.

Create a query to display only membership ID, first name. Last name and
status. Those with executive members

v.

Create another query displaying all fields to display members with
membership fee between 20000 and 80000 call it ―paid up members.‖

vi.

Create another report using the query by home town grouping all records by
town; name the report as members by Hometown.

vii.

Create another report using the query members by home town grouping all
the records by town; name the report as members by home town.

QUESTION 23.
The table below gives information on some students in a certain secondary school
about the registration numbers, names, classes, age and names of house where
they reside.
REG. NO
001
002
003
004
005
006
007
008
009
010

NAME
Lule S
Kizza V
Omeda A
Semebwa S
KibuukaD
AmitJ
Onen L
Semuli M
Sendi J
Kasanya D

CLASS
S.2
S.2
S.4
S.3
S.2
S.1
S.3
5.5
S.1
S.4

AGE
15
14
16
16
13
12
17
17
11
15

HOUSE
Muteesa
Muteesa
Samba
Bikanga
Simba
Lumumba
Lumumba
Simba
Muteesa
Bikangaga

i.

Create a table and name it personal details with fields.

ii.

Enter the data above in the data table created using data types.

iii.

Create a query for Muteesa and Samba house member

iv.

Create query for students whose age ranges from 12 to 16.

v.

Create a report that shows the following fields, Class, Names and house.

vi.

Save your data base file as report. JlI
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QUESTION 24.
The heights and weights of players in a football team were taken and their
respective measurements were as follows.
SHAN

177,63

75.2

ABDUL

164,59

56.1

NALIANYA 1

183,84

85

OLOO

168,90

85

SUZUKI

158,82

72

CHEGE

168,80

78

LETOIYA

168,70

56.3

MUTUA

172,75

69.9

MWANGI

174,65

71

ROTICH

181,68

68

KIMATHI

173,95

56

The heights are centimeters while the weights are in kilograms.
a) create a database file team that can be used to store the above data
b) Enter the above records in the database you have created
c) It is required that the total number of goals scored by each player in the
previous matches be included in the database file.
d) The first two players have two goals each, mutual and letoiya have scored
three goals each, Suzuki and Kimatha have not scored any goal, while the
rest have scored 1 goal each. Include these details in the database file and
save as “TEAM 1”
e) Make the field containing names to be primary key.
i.

Sort the database record in descending order of players goals scored and
save the data base as ―Team ―

ii.

Create a report that displays the names, heights and goals scored for players
whose weight are below 75 kg.

iii.

Make a print out.
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QUESTION 25.
A school in Kiboga County, Mubende district has a population of 500 students and
various subject departments. Some twenty students, 12 of the girls live in Maria
and Theresa houses. The other 8 are boys who live in Muteesa and Kabalega
houses.
Required to:
a. Create a database file with fields.
b. Surname, Last Name, Age, Sex, Registration Number, Address, Class and
House for 20 students.
c. Sort the data in (b) above using, Surname as the key field.
d. Save your data base file on the Desktop as ―D file.‖
e. Design a table in (b) above in a datasheet view
f. Create a query for house members of Maria and Kabalega house.
g. Create a report showing the fields: Surname, Class, and House.
h. Save your table on the ―Desktop‖
i.

Using any available database software, create a database call it Old Students
Association.
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RESOURCE QUESTIONS FOR Ms PUBLISER.
(ELECTRONIC PUBLICATION)
QUESTION 1
Using Microsoft office Publisher, design the business card of an individual working
in any Institution of your choice. Include:
a. Logo of the institution.
b. Name of the institution.
c. Name of the person.
d. Job description of the person.
e. The address.
f. Office and Mobile telephone contacts.
g. Email address.
NOTE: Your cards should be attractive and rich in graphics.
h. Save your file as business and the print preview of 6 cards per A4 paper.

QUESTION 2.
Using a Desktop Publishing Program of your choice, design the following cash
Receipt and make four Copies on your publication page. Set the guides to the
following positions: 2cm, 10.7cm, 11cm and 19.7cm (all vertical) and 1.5cm,
11.5cm, 12cm, and 22cm horizontal.
QUESTION 3.
Using Microsoft publisher, design the business card of an individual working in an
institution of your choice. Include;
a) Name of the institution
b) Log of the institution
c) Name of the bearer of the business card
d) Job description of the person
e) Physical address, including e-mail
f)

Office and mobile telephone contacts

Note:
i.

Your cards should be attractive and rich in graphics

ii.

Adjust the paper size using the following dimensions to a width of 8.4 inches
and height 11.8 inches
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iii.

Adjust the top and bottom margins to 0.4 inches.

iv.

Adjust the left and right margins to 0.3 inches

v.

Save your files as business card and then print preview of six cards per A4
paper.

QUESTION 4
Using any desktop publishing software to design a certificate of excellence for
KIRYAMENVU SENIOR SECONDARY senior six (S.6) candidates who have excelled
in the following application packages: ms excel, ms power point, ms access and ms
publisher. Provide space for the signatures of the head teacher and the head of ICT
department.
a) Adjust the paper size to a width of 11 inches and a height of 8.5 inches.
b) Insert a clip art to represent the owner‘s photograph.
c) Use your name as the owner of the certificate,
d) Insert your name and personal number in the footer.
e) Save and print your publication.
QUESTION 5.
Using suitable publishing software, design eight identical business cards titled on
A4 page size, 3.5‖ width and 2‘ height.
a) The cards‘ layout and spacing is as follows;
i.

Left and right margin should be 0.5‘

ii.

Top and bottom margins 0.7‘

iii.

The vertical and horizontal gap between cards 0.6‘

b) The details of the card are:
i.

A logo of the company at the left hand side of the card. Provide the logo

ii.

A company name of your choice.

iii.

Job title e.g. managing director.

iv.

Your name e.g. Aisha Kainembabazi.

v.

Contact address, phone and e-mail.

c) Include crop marks around each card.
d) Save the publication as ―my business card‖
e) Print your work.

A complete Practical Guide to O ‘level A ‘level and Institutions

Page 129

QUESTION 6
Use suitable desktop publishing software; design a certificate to be awarded to
students who have worked tirelessly for patriotism club in your school.
a. Apply a suitable boarder to the certificate and a nice looking background.
b. Use appropriate signatories to your certificate i.e. head master, patron and
club president.
c. Use suitable fonts i.e. type, size and colors for the text you have inserted.
d. Design logo for your certificate
e. Save the certificate as “Patriotism club — your names”
f. Copy the saved file in your folder. Produce the print out.
QUESTION 7
You are required to Prepare the Cash receipt as it appears below.
Table 59
KKTRANSPORTERS LIMITED
P.O.BOX 7000
KAMPALA.
Dealers in electronics and electricity equipment
Item

Quantity

Unit Price(Shs)

Amount (shs)

Figure 15
a) Font size should be 12 for the three line heading and the rest of the work in
font size 10.
b) Font color is black.
c) Font face (style) is Anal Narrow.
d) Insert header your name and footer your index number.
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QUESTION 8
Using a suitable publishing software, design eight identical business cards titled on
A4 page size ―width and 2‖height
a) The cads‘ layout and spacing is as follows:
i.

Left and right margin should be 0.5

ii.

Top and bottom margins 0.7‖

iii.

The vertical and horizontal gap between cards 0.6‖

b) The details of the card are:
i.

A logo of the company at the left hand side of the card. Provide the logo

ii.

Company name of your choice

iii.

Job title e.g. Managing Director

iv.

Contact address, phone and e-mail

c) Include crop marks around each card
d) Save the publications as ―my business card‖
e) Print your work.
QUESTION 9
Design a certificate for any club of your choice in your school.
i.

Apply a border to detach your certificate and an appropriate background.

ii.

Use appropriate fonts.

iii.

Give two Signatories to your certificate.

iv.

Apply good graphics and graphical colors to your certificate.

v.

Save it in the name of your club.

vi.

Print your work.

QUESTION 10
Design a letterhead for your company which should among others have a logo,
address, date, well designed in appropriate fonts.
a) In the normal view, list down the products offered by your company.
b) Indent your work ―0.5‖ to the left and ―0.5‖ to the right and apply 1.5 line
spacing.
c) Apply a page borders on your document
d) Save your work with your name as a file name
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e) Print a copy of your work.
QUESTION 11
You have been chosen a graphics designer of your school. Your responsibility i to
develop a logo for the Writers‘ club in your school.
a) Using only “three” - “four” letters to abbreviate the club name, Create a
logo to be used by the writers‘ club of your school.
b) Apply good graphics and graphical colors for the club to your logo.
c) Use appropriate fonts.
d) Use color patterns in any two of the letters.
e) Save your work in your names and index number.
f)

Make a hard copy out of your work.

QUESTION 12
a) Using suitable Desktop publishing software, design four identical greeting
cards to your friends for the Christmas festive season.
b) Apply good minimal graphics and graphical colors to your greeting card.
c) Make sure your card carries a season message and if so enticing to the
target group.
d) Group these four identical greeting cards and paste them to the next page to
make eight cards on two pages.
e) Save your work in your names
QUESTION 13
a. You are required to design the logo below as it appears.

b. Using suitable desktop publishing tools,
i.

Rotate the logo to a 900 angle.

ii.

Group the letters in the logo
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c. Make six identical logos form the same logo.
d. Save your work.
e. Make a print out.
QUESTION 14
a) As graphics designer of your school, design a flyer for your favorite elections
candidate on the post of Headboyship of your school.
b) Your flyer should include.
i.
ii.
iii.

The Candidates‘ Names
Post and Class.
The school motto.

c) It should among others include the best and appropriate fonts and colors.
d) Save your work.
e) Make two hard copies out of your work.

QUESTION 15
a) Using Microsoft Office Publisher, develop a simple webpage of your school. The
page should among others have all features of a good webpage.
b) Include the following on your page;
Any introductory information about your school; Among the introductory
information include;
i.
ii.

The School Mot
Subjects offered.

c) A link for each of the departments in your school. (Physics MathDepartment,
Languages Department, Chemistry Biology Department, theHistory, CRE,
Geography, the Commerce, Entrepreneurship and Economics Department. .
d) Include appropriate images on your home page.
e) Table showing the classes the school has an enrolment for each class.
e) Appropriate graphics and colors.
f) Save your work as a webpage.
g) Import it to the available browser offline.
h) Print out the page.
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QUESTION 16
Using any publication software design a certificate that should be awarded to
senior six candidates of your school who have excelled in the followingcomputer
applications.
1.
2.
3.
4.
5.

Ms
Ms
Ms
Ms
Ms

Word.
Excel.
Access.
Power point.
Publisher.

Additional information








Heading should be the name of your school.
Your name as the owner of the Certificate.
Insert signatories for the head teacher and HOD ICT
Use appropriate font colors designs and styles.
Insert a textural background of your choice.
Insert a logo of your choice.
Save your work as applications your name e.g. Application John. Print your
work.

QUESTION 17
Titus is the new Marketing Manager of a company called ―inspirational Aspirations
Ltd‖. The company is located at Block 110, 7th street of industrial area. The
contact address is P.0. Box 130, Nakasero. His email Aspiration.com and
+256414285193 respectively.
Using a desktop publishing application of your choice, help Titus to come out with
a designer ―business card‖ through the following activities.
a) Use an appropriate page design to make eight identical cards per page.
b) Save your publication as ―your name‖.
c) Using a ruler guide measure take the following card dimensions-width 3.5 inches
and height 2 inches.
d) Design one card with the following details: Company logo of your choice;
Company name; Name of employee; designation; Location; Contact address; Email
and Telephone contacts.
e) Select all the contents on the card and group them into one object.
f; Apply an appropriate background color to your card.
g) Insert your name and personal number as a footer.
h) Save and print out a copy of your work.
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QUESTION 18
Kawomera Restaurant LTD has embarked on re-designing their Menu card offered
to customers.
As a Desktop Publisher expert, you have been appointed to assist the marketing
team in re-designing a menu card for the restaurant as a marketing and persuasive
tool. The fonts, borders and graphics used should be relevant to the publication as
may be available in your software.
a) Prepare a publication with the following paper specifications


Paper size set to A4, Portrait



Set margins to 10mm (0.4‖) all round

b) Include the following on your menu


Name and address of the Restaurant



Available food stuffs and drinks served at the restaurant in threephases Breakfast, Lunch and Supper.



A log at the Top Right.



Necessary C1T arts.

c) Format your page as follows


Simple background color.



Bolden and centre the address.



Set the transparency of the fill color to 25% for all the clips arts in themenu.

d) Include a logo at the top left of your menu.
e) Include a Header ―your name‖ and a footer your ―Index Number‖.
f) Save your work as Menu and Print a copy.

QUESTION 19
Using any available publishing software, design an invitation wedding cardwith the
following:
a) Names of the couple to be married and respective parents.
b) Picture of the couple.
c) Mobile phone numbers of organizers.
d) Date and location/church for the weeding of these couple.
e) The invitation message.
f)

Venue of, church, reception and after party.
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g) Attractive background and font text colors.
h) Save the file as weeding.
i)

Print the work on a page of paper.

QUESTION 20
Eastern pride high school would like to have a calendar designed for it,
a) Use any publishing software; design a calendar for the school to includethe
following information:
i.

Name of the school, location and contact information.

ii.

Badge of the school (either an object drawn or as clip art).

iii.

An image of clip art to represent the school,

iv.

School motto.

b) The calendar area should be of font monotype corsiva size 36, colour dark blue.
c) Pill the table part with an orange color. Set the color to 56% transparency.
d) Insert your name and combination in the footer.
e) Save your work as your name and combination.
f) Print your work.
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WEB DESIGN.
Introduction
Web design is a process of planning and creating a website. While designing
websites, texts, images, digital media, interactive elements and tables can be used
by the web designer to produce an outstanding website that can be seen on the
web browser.
Web design basically deals with developing preliminary web pages
A web design program/application is a computer program that is used to create,
edit and upload web pages and websites.
Examples of web design software/application include;
i.
ii.
iii.
iv.
v.
vi.
vii.
viii.
ix.

Html-kit tools.
Serif web Plus
Coffee Cup Visual Site Designer.
Web Easy Professional.
Net Object Fusion
Adobe Dream Weaver Cs.5.
Ace HTML 6 Pro
Ultra Edit.
Web studio

What is a web site?
One can define a web site as a collection of related web pages.
Or
This is a document available on the World Wide Web that is created using html
(Hyper Text Markup Language) and can be viewed with an internet browser. For
instance Google, Netscape, explorer among others.
A web page can contain graphics, image, text, links and other multimedia
components. A web page can be made up of a number of separate paged
documents. It is normally a collection of documents that make up a website.
A home page: this is main page or the cover page of the web document that
contains an index or table of content to the rest of the documents.
Usually, a web site after being fully developed/designed, it is hosted on at least one
web server that is accessible via a network such as a the internet network, or any
other available private network.
The most common way to get a web site is to feed in or enter that Uniform
Resource Locator (URL).
• A Uniform Resource Locator is a unique address of the file that is accessible
over the internet.
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INTRODUCTION TO BASIC HTML.
A html stand for Hyper Text Markup Language. It is specifically a language for
displaying web pages. It is not a programming language but a markuplanguage.
A markup language is a set of markup tags.
Tags majorly give the browser instructions on page display. They include
thestarting tag (<) and the closing tag (>) they are normally enclosed in angle
brackets i.e.
<Html>. They normally come in pairs e.g. <h1> and </h1>. The first tag in the pair
is the “start tag” and the second is the “end tag”.
A html file is a text containing small markup tags.
A markup tag is one that tells the web browser how to display the page. AHTML
must have an htm or html file extension. A HTML file can he created using a simple
text editor.
Let‟s try to work out with HTML
In window environment, follow the following steps.
1.
2.
3.
4.

Click start on the task bar
Select all programs
Select accessories
Select notepad.

Here, the first tag on your html document is <html>. This tells your browserthat
this is the start of an html document.
The last tag should be </html>. This tag tells your browser that this is the end of
the html document.
The text between the <head> tag and </head> tag is the header information.
Header information is not displayed in the browser window.
The text between the <title> ta and </title> tag is the title of your document. The
title is displayed in your browsers‘ caption (title bar).
The text between the <body> tag and Thody> tag is the text that will be displayed in
your browser.
Example;
<Html>
<Head>
<Title> title of the page </ title>
</head>
<Body>
This is my first home page <b> this text is bold </b>
</body>
</html>
Save the file as ―home page.htm‖ or homepage.html‖ on your desktop.
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Elaboration;
In the above example <b> tag and </b> tag makes the text between bold.
Open the file you have just created by using the browser on your computer.
(Internet explorer, Firefox or opera)
You should then be able to see an address in the dialog box for example
“C:/desktop/homepage.htm” this is if you are using windows XP. And for windows
7, one hou1d be able to see file:///C:users/usernarne/Dsektop/homepage. htm
Saving a html file:







Select file (Alt + F) then you will be presented with a dialog box
Select Save As.
Make a new folder and name it whichever name you want. Then open it.
Type ―page 1‖.html on file name
Select the destination/file location
Then save.

Changing colors:
To change background colors, keep the other line written and follow the following
steps;
 <BODY BGCOLOR= ―#CCFFCC‖>
</BODY>.
Note: if the background colors are specified that is not one of the known colors,
thenthe browser will usually pick the closest of these colors to use.
Formatting tags. (Bolding)
We can make things bold by
 = <BODY>something or what you want to bold <B>cool</B></BODY>
 Cool
 What we are trying to tell the browser is that at the <B> start making things
bold
 And at the </B>stop making things bold.
Formatting tags (italics)
The same principal applies to italics
 <BODY>something<|

|

 rz‘ <B>cool</B>‘</BODY>.
Something really cool.

Underlining
 <BODY><U>something or what you want to underline </U></>really</ I>
 <B>cool</B></BODY>
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Something really cool
Font sizing
To change the font size, you need to first add the font tag
 First add the <FONT> tags.
 <BODY>something to font size
 <FONT>cool</FONT></BODY then specify a SIZE attribute.
 <BODY> something really <FONTSIZE=6>cool</FONT></BODY>
i.e. something really cool

RESOURCE QUESTIONS FOR WEB DESIGN.
1. Using any available web publishing software, design a web page for a hotel.
Make sure our home page is impressive but not too slow to download.
You are expected to include:
a) page title
b) less graphics
c) Work (text) text between 150 — 200.
d) not more than two links
e) an ordered list (6 hobbies)
f)

good designing

g) Creativity.
as a member of the environment club you are assigned to design a web page‖ on
the effects of pollution on society‖
You are expected.
Include the following
i.

page title

ii.

less graphics

iii.

not more than 100 words

iv.

one link to environ@yahoo.com

v.

creativity

vi.

date/source/feed back

b. the pages should be well linked
c. save your work as ―My web‖
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2. Using any available web publishing software, design a website for the ministry of
education.
You are expected to include the following:
a. A page title
b. Appropriate graphics
c. A 100-120 word text
d. 1 link(for the ministry‘s email address)
e. Table showing the duties of the ministry
f. Layout
g. Creative designing
h. Save your work as education ministry.
3. You are contracted to design a web page for Mukono industries. As a web
master, you are required to include:
i.

A page title

ii.

Appropriate graphics

iii.
iv.
v.
vi.
vii.
viii.

Not more than 120 words on the company and its products
A link for each of the products
A layout
The author of the text who can be contracted•
Creativity
Save your web site as Mukono.

4. Using any available web publishing software, design a two page web site for your
former primary school:
i. The first page is the index or home page, it should include:
a. The name of the school and the school logo.(the logo does not have to be the
actual logo of the school)
b. Any introduction information
c. Address of the school (does not have to be the actual address)
d. A facility for visitors to sd an e-mail to the school.
e. Navigation bars
(ii) The second page should contain a bulleted list of the department in the school,
and a table showing at least four teachers indicating the classes and the respective
subjects they teach.

The two pages must be linked together.
•

Save your website as name primary school.

•

Print out the home page and the linked pages.
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5. Using web design software of your choice, design a web site for your former
primary school which includes:
a. An index page with the name of the school and a picture of an important
feature in the school. (The picture does not have to be the actual one but
should be closely related.)
b. One page on the,
i.

Different subjects offered

ii.

School admission

iii.

Sports and co- curricular activities.

iv.

Neighboring community.

6. Using any available publishing software design a school home page .make sure
the home page is very impressive but too slow to download.
You are expected to include the following,
a. A page title
b. Appropriate graphics
c. A 100-l20 word text
d. 1 link (for the school email address)
e. Table — showing at least four years UCE performance by the school.
f. Layout
g. Creative designing
h. Save your work as my school

7. A company called atekere milk production and accessories is willing to employ
your services as a website authorizing specialist to design a website for them. This
will include the following:
The page should have,
I.
II.

Provision for inserting the company‘s products picture.
Eight departments i.e.



Director‘s office



Production department‘s Office



Human resource office



Accounts office



Welfare department



Engineering department



Security department
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Transport office

a. Create a link on the production department in (a) (ii) above that will lead you to
page explaining what the department does.
b. Include the company‘s vision, mission, and core values‘ statement at the bottom
of the index page.
c. Provision should be made for originality, creativity innovation andappropriate
use of graphics.
d. Save your work in your name and index number
e. Print your work.

8. Using any available web publishing software, design your school‘s home page
make sure that your school is well represented in this project.
You are expected to include the following:
a. Page title
b. Less graphics
c. Word (text) between 100-1 10.
d. 1 link (for the school‘s e-mail address.)
e. Table -showing four departments of your school.
f. Designing
g. Creativity.

9. You are contracted to design a web page for Mukwano industries. As a web
master, you are required to include:
a. Page title.
b. Appropriate graphics
c. Not more than 120 words on the company and its products.
d. A link for each of the products.
e. A layout.
f. The author of the text who can be contacted.
g. Creativity.
h. Save your work as on a RW CD as Mukwano.
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10. The great lakes region is moving into a political, economical and social
federation. The three countries are determined to form the most powerful cooperation.
Using any availab1e web publishing software, design a web page for this
community Make sure your home page is impressive, creative arid has appropriate
graphics,and not too download.
a. The home page should have a short story about
b. The home page should have a link of four countries.
c. Each link page in (ii) above should have a short story about that country.
d. Indicate your name index number as footer.
e. Saveyourwork GRELAR
f. Print your work including your skills.

11. As a professional web designer, you are contracted to design a web page Mr.
M&J hotel Bwebajja. This should include among others,
I.
II.

Provision for inserting the company‘s products picture.
Eight departmentsi.e.


Director‘s office.



Procurement department.



Human resource office



Account‘s office.



Operation‘s department



Engineering department



Security department



Transport office.

a. Create a link of the operations department in (a)(ii)above that will lead you to
page explaining what the department does.
b. Include the company‘s vision, mission and core values‘ stamen at the bottom
of the index page.
c. Provision should be made for originality, creativity, innovation and
appropriate use of graphics.
d. Save your work in your name and index number.
e. Print your work.
12. Using any available publishing software, design a website about your personal
information. ).
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a. Create a home page for your personal information with appropriate links to
other following pages.
b. Create other pages with the following information.
Page I: page title, bio-data e.g. name, age, nationality and religion.
Page II: a table of schools attended, period of attendance and qualifications
acquired.
Page III: a bulleted list of activities and responsibilities held e.g. had prefect.
Page IV: hobbies and special skills.
Note:
I.
II.

Create a moving (marquee) page title.
Use appropriate graphics.

III.

Insert a personal e-mail address (e-mail hyperlink) of the page.

IV.

Save your work as name and index number.

V.

Print your work.
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